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FOR PRODUCTS PURCHASED IN UNITED STATES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have or intend to have on your network. For
computers or workstations attached to a public messaging system, the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education or charitable institution pricing program, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If for any reason you are
dissatisfied with the Software, return the product package, with
proof of purchase, to your reseller within 90 days for a full
refund. If any materials or media in this package are defective,
return them to Novell within 90 days of the date of purchase, and
they will be replaced at no charge.

These warranties are in lieu of any other warranties, express or
implied, including the implied warranties of merchantability and
fitness for a particular purpose. In no event will Novell be liable
to you for damages, including any lost profits, lost savings, or
other incidental or consequential damages arising out of your use
of or inability to use the Software, even if Novell or an authorized
Novell representative has been advised of the possibility of such
damages.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation of liability
and may not apply to you if prohibited by the laws of your
jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell’s current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions. This Agreement shall be governed by
the laws of the State of Utah.

U.S. GOVERNMENT RESTRICTED RIGHTS.
The Software and any accompanying materials are provided with
Restricted Rights. Use, duplication, or disclosure by the Government
is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The
Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software-Restricted Rights at 48 CFR 52.227-19, as
applicable. Contractor/manufacturer is Novell, Inc., at the address
below.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement,
please refer to the Questions and Answers which follows this
Agreement. If you have further questions about this Agreement or
about special programs for educational or charitable organizations,
please write to WordPerfect, Novell Applications Group, Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399, or call
(801) 225-5000.



FOR PRODUCTS PURCHASED IN ALL OTHER COUNTRIES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on
which you use the Software.

If you have licensed this Software under an education or charitable
institution pricing program, you may not create an extra copy of the
Software under this provision for use on a home or portable
computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If any materials or media in this
package are defective, return them within 90 days of the date of
purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT
WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OF OR INABILITY TO USE
THE SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions which may supersede this limitation. As a
result, this limitation of liability may not apply to you if
prohibited by the laws of your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell’s current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
contact your local WordPerfect office or authorized distributor or
write WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A., or call
(801) 222-4200.



FOR PRODUCTS PURCHASED IN AUSTRALIA-NEW ZEALAND
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorised to use a copy of the Software on a home or
portable computer, provided the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software.

If you have purchased this Software under an educational institution
or charitable institution pricing programme, you may not create an
extra copy of the Software under this provision for use on a home or
portable computer.

LIMITED WARRANTY/LIMITATIONS OF LIABILITY
A. This Part A is subject to provisions of Part B which follows
below. This Software is licensed AS IS. If any materials or media in
this package are defective, please return them within 90 days of the
date of purchase, and they will be replaced free of charge.

These warranties are in lieu of any other warranties, express or
implied, including the implied warranties of merchantability and
fitness for a particular purpose. In no event will Novell be liable to
you for damages, including any loss of profits, lost savings, or other
incidental or consequential damages arising out of your use of or
inability to use the software, even if Novell or an authorised Novell
representative has been advised of the possibility of such damages.

B. Trade Practices Act. Where any legislation such as the Trade
Practices Act 1974, implies into this Agreement any condition or
warranty and that legislation avoids or prohibits provisions in a
contract excluding the application of the condition or warranty, the
liability of Novell for any breach of the condition or warranty is
limited at the option of Novell to any one or more of the following:
a) if the breach relates to goods, replacing the goods or the payment
of the cost of acquiring equivalent goods or repairing the goods or
payment of the cost of repairing the goods; b) if the breach relates to
services, the supplying of the services again or the payment of the
cost of having the services supplied again.

Nothing in this Agreement is intended to restrict or exclude any
liability of Novell under Part VA of the Trade Practices Act 1974.

CUSTOMER SUPPORT
Subject always to Novell’s current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programmes for educational or charitable organisations,
please contact your local WordPerfect office or authorised distributor
or write WordPerfect, Novell Applications Group, Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.,
or call (801) 222-4200.



FOR PRODUCTS PURCHASED IN UNITED KINGDOM
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

SPECIAL PROVISIONS
Novell grants you a special licence to place an extra copy of the
Software on a home or laptop computer, as long as the extra copy is
never loaded at the same time the Software is Loaded on the primary
computer on which you use the Software.

Special licensing provisions may apply for a qualified educational of
charitable institution.

LIMITED WARRANTY/LIMITATION OF LIABILITY
If you enter into this Licence agreement as part of a consumer
transaction: if any materials of media in this package are
defective, return them within 90 days of the original date of
purchase and Novell will replace them at no charge. THE
FOREGOING DOES NOT AND WILL NOT AFFECT YOUR
STATUTORY RIGHTS AS A CONSUMER.

If you do not enter into this Licence Agreement as part of a
consumer transaction: THIS SOFTWARE IS LICENCED AS IS.
If any materials or media in this package are defective, return
them within 90 days of the original date of purchase and Novell
will replace them at no charge. The right to use the Software is
granted without any further warranty, condition, representation
or other term express or implied relating to the performance,
quality or fitness for use of the Software or written materials
accompanying the Software. Novell shall not be liable for any
loss or damage of any kind (other than personal injury or death)
arising from use of the Software or accompanying written
materials or from errors, deficiencies or faults therein, whether
such loss or damage is caused by negligence or otherwise.

CUSTOMER SUPPORT
Subject always to Novell’s current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement shall be unlawful, void, or for any
reason unenforceable, then that provision shall be deemed severable
from this Agreement and shall not affect the validity and
enforceability of any of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organisations, please
contact your local WordPerfect office or authorised distributor or
write WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A., or call
(801) 222-4200.



FOR PRODUCTS PURCHASED IN CANADA (ENGLISH)
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on
which you use the Software.

If you have licensed this Software under an education or charitable
institution pricing program, you may not create an extra copy of the
Software under this provision for use on a home or portable
computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. IF FOR ANY REASON YOU
ARE DISSATISFIED WITH IT, RETURN THE SOFTWARE,
INCLUDING ALL MATERIALS, WITH PROOF OF
PURCHASE TO NOVELL WITHIN 90 DAYS OF THE DATE
OF PURCHASE FOR A FULL REFUND. If any materials or
media in this package are defective, return them within 90 days
of the date of purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT
WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OF OR INABILITY TO USE
THE SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions which may supersede this limitation. As a
result, this limitation of liability may not apply to you if prohibited
by the laws of your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell’s current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement,
please refer to the Questions and Answers which follows this
Agreement. If you have further questions about this Agreement or
about special programs for educational or charitable organizations,
please write to WordPerfect, Novell Applications Group, Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399, or call
(801) 225-5000.



CONTRAT DE CONCESSION DU DROIT D'UTILISATION
DES LOGICIELS EN VERSION FRANÇAISE ACHETÉS AU CANADA

TERMES ET CONDITIONS D'UTILISATION
Novell, Inc. (Novell), vous concède le droit d'utiliser le Logiciel,
conformément au nombre de copies et à la plate-forme spécifiés par le
Formulaire de preuve d'achat inclus dans le coffret du Logiciel. Si le Logiciel
constitue une mise à jour d'un produit de WordPerfect,Novell vous concède le
droit d'utiliser la présente version ou la version antérieure du Logiciel, mais
non ces deux versions simultanément.Le présent Contrat de concession annule
ou remplace tout contrat antérieur.

LOGICIEL CLIENT Sur les ordinateurs ou postes de travail connectés à un
réseau, le nombre de copies du Logiciel réputées «utilisées» correspond au
nombre maximum de boîtes aux lettres que vous êtes autorisé à installer. Sur
les ordinateurs ou postes de travail connectés à un système de messagerie
publique, on considérera que le nombre de copies du Logiciel réputées
«utilisées» correspond au nombre maximum d'ordinateurs sur lesquels le
Logiciel est chargé en mémoire simultanément, ou au nombre maximum
d'ordinateurs sur le disque dur desquels le Logiciel est enregistré.

LOGICIEL DE SERVEUR DE MESSAGES Une seule licence est requise
pour utiliser le Logiciel sur un serveur de messages, ou sur un ordinateur, poste
de travail ou serveur de fichiers faisant office de serveur de messages,
desservant tous les ordinateurs d'un domaine.Un «domaine» est le
regroupement logique de plusieurs bureaux de poste et/ou passerelles gérés par
un seul serveur de messages.

LOGICIEL DE PASSERELLE Destiné aux ordinateurs ou postes de travail
non connectés à un réseau, ou aux serveurs de réseau, le Logiciel est réputé
«utilisé» lorsqu'il est intégralement ou partiellement chargé en mémoire vive
ou en mémoire virtuelle, ou bien enregistré sur le disque dur ou tout autre
dispositif de stockage.

Vous êtes autorisé à copier la documentation écrite, qui accompagne le
Logiciel, pour faciliter l'utilisation légale du Logiciel. Vous pouvez aussi
réaliser une copie d'archive du Logiciel pour chaque licence couverte par le
Contrat.

RESTRICTIONS
Vous ne pouvez en aucun cas louer ou céder en location le Logiciel sans
l'accord écrit de Novell. Vous ne pouvez en aucun cas décompiler,démonter,
inverser, reproduire, créer une oeuvre dérivée, ou autrement utiliser le Logiciel
en dehors des cas expressément prévus dans ce contrat. Quel que soit le
nombre de supports inclus avec le Logiciel, vous n'êtes autorisé à utiliser que
le nombre de copies indiqué sur le Formulaire de preuve d'achat. L'achat de ce
Logiciel peut être réglementé par des conditions spéciales, imprimées sur
l'emballage contenant le Logiciel.

DISPOSITIONS RELATIVES AUX ORDINATEURS PERSONNELS ET AUX
PORTABLES
Vous êtes autorisé à utiliser une copie supplémentaire du Logiciel sur un
ordinateur personnel ou un ordinateur portable. Cette copie ne doit en aucun
cas être chargée sur cet ordinateur personnel ou portable lorsque le Logiciel est
déjà chargé sur votre ordinateur principal.

Si le Logiciel a été acheté dans le cadre d'un programme d'éducation ou
caritatif, vous n'êtes pas autorisé à réaliser une copie supplémentaire du
Logiciel pour votre ordinateur personnel ou portable.

GARANTIES-LIMITATIONS DE RESPONSABILITÉ
CE LOGICIEL VOUS EST CONCÉDÉ EN LICENCE EN L'ÉTAT ; SI
POUR UNE RAISON QUELCONQUE, VOUS N'ÊTESPAS SATISFAIT,
VOUS DISPOSEZ D'UN DÉLAI DE 90 JOURS, À COMPTERDE LA
DATE D'ACHAT, POUR RETOURNER LE LOGICIEL,Y COMPRIS
TOUS COMPOSANTS RELATIFS, ACCOMPAGNÉ DU FORMULAIRE
DE PREUVE D'ACHAT À VOTRE REVENDEUR, ET VOUS SEREZ
INTÉGRALEMENT REMBOURSÉ. En outre, Novell s'engage à remplacer
gratuitement toute disquette ou élément défectueux contenu dans l'emballage
qui sera retourné dans un délai de 90 jours, à compter de la date d'achat.

TOUTE AUTRE GARANTIE, EXPRESSE OU IMPLICITE,Y COMPRIS
TOUTE GARANTIE IMPLICITE D'APTITUDE À LA
COMMERCIALISATION OU D'APTITUDE À UNE UTILISATION
PARTICULIÈRE, EST EXPRESSÉMENT EXCLUE. EN AUCUN CAS,
NOVELLNE SAURAIT ÊTRE RESPONSABLE DES DOMMAGES
DIRECTS OU INDIRECTS, Y COMPRIS TOUTE PERTE DE PROFIT
OU DE BÉNÉFICE OU AUTRES DOMMAGES INDIRECTS OU
ACCESSOIRES CAUSÉS PAR L'UTILISATION OU L'IMPOSSIBILITÉ
D'UTILISATION DU LOGICIEL ET CE, MÊME SI NOVELL OU L'UN
DE SES REPRÉSENTANTS AGRÉÉS A ÉTÉAVERTI DE LA
POSSIBILITÉ DE TELS DOMMAGES.

Certaines juridictions ne permettent pas l'exclusion ou la limitation de garantie
implicite ou la limitation de responsabilité pour des dommages indirects ou
accessoires. En outre, certaines juridictions prévoient des dispositions
particulières relatives à la protection du consommateur, lesquelles pourraient
remplacer les dispositions qui précèdent. En conséquence, la limitation de
responsabilité peut, conformément à la loi en vigueur dans votre juridiction, ne
pas vous être applicable.

ASSISTANCE TECHNIQUE
Dans le cadre de sa politique d'assistance technique, Novell s'efforcera de
répondre aux questions d'ordre technique concernant le Logiciel. Cependant, il
est convenu que ce service ne constitue qu'une obligation de moyen et que
Novell ne saurait satisfaire toutes les demandes d'assistance. Novell ne
supportera le Logiciel que dans la mesure où celui-ci est utilisé dans les
conditions et selon les configurations matérielle et logicielle pour lesquelles il a
été conçu. Les services offerts par l'Assistance technique peuvent être modifiés
sans préavis.

GÉNÉRAL
Au cas où une disposition quelconque de ce contrat serait illégale, nulle ou non
exécutoire, pour quelque raison que ce soit, cette disposition sera réputée non
écrite, et la validité et le caractère exécutoire des autres dispositions de ce
contrat n'en seront pas affectés.

RÉPONSES À VOS QUESTIONS
Si vous avez des questions à propos de ce Contrat, ou à propos des conditions
spéciales accordées aux établissements scolaires et aux organisations
caritatives, veuillez contacter la filiale dont vous dépendez,ou votre
distributeur agréé, ou écrire à WordPerfect, Novell Applications Group, Attn.
Sales Center, 1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A., ou
appelez le (800) 321-2318.



Questions and Answers
Q. How do I license for the use of workstations located on my network?
Can I license based on concurrent access to the system?

A. Each defined user on the GroupWise messaging system is assigned a
mailbox for persistent storage of calendar and electronic messaging data.
Each mailbox must be licensed and is considered "in use" after it has
been defined. Regardless of whether the user is actually logged into the
post office, the mailbox is actively available for delivery of messages,
processing of server-based rules, and other messaging services.

Q. If I have three users who share a workstation (they work on rotating
shifts), do I need one license or three to cover their use of the software?

A. If each of the three users has an individual mailbox, then three
licenses are required. If all three users share the same mailbox (defined
by job function, perhaps, rather than individual user), then only one
license would be required.

Q. Do I need to worry about which user runs the various Client
versions of the GroupWise software? If I'm migrating my users from
DOS to Windows, do I need to modify my license for the software?

A. No. Because the licensing of Client software is done on a per-mailbox
basis, any platform version of the GroupWise network Client software can
be used to access a licensed mailbox.

Q. If I have a user who runs the Client software on more than one
workstation, do I need more than one license?

A. No. Only one license is needed to cover access to the licensed
mailbox from one or more workstations.

Q. Am I required to license resources?

A. No. The resources defined on the GroupWise system do not need to
be licensed.

Q. How can I tell how many licenses I need?

A. The Administration program provides a count of all mailboxes
installed on the post office, domain, and system. The number of
licenses for which you are responsible equals the number of mailboxes
installed on the part of the system that is under your jurisdiction.

Q. How do I license my users who use the Remote Client versions of
the software?

A. The Remote Client software is licensed by the same mailbox license
mechanism used by Network Clients. Any platform version of the
Remote Client software can be used without additional licensing to
access any licensed mailbox.

Q. Can my users have a copy of the software loaded on their home
computer and laptop computer as well as on their network computer?

A. Yes. As long as all of these workstations where the software is stored
are used to access the same licensed mailbox, they can all operate under
a single mailbox license.

Q. How is the Administration software licensed?

A. There is no license tied specifically to the Administration software.
It is provided in the Client package and can be used on any system that
contains licensed mailboxes.

Q. How are the multiple Message Server programs licensed?

A. The GroupWise Message Server software is licensed on a domain
basis by Message Server platform. Any and all Message Server programs
required for the operation of the GroupWise system on a supported
platform are licensed for use on a single domain. Additional Message
Server licenses are required for each additional domain serviced.

Q. Can I run the Message Server programs licensed under the domain
license on separate workstations or file servers?

A. Yes. As long as these programs are run to support the messaging
services of a single domain, they can run on one or more workstations
or file servers.

Q. If I want to run different platform versions of the Message Server
programs on the same domain (such as MS and ADS OS/2, and OFS
NLMs), do I need one license or two?

A. In this case, even though the servers are supporting a single domain,
you would need two Message Server licenses because the Message Server
is licensed by platform and two platforms of Message Servers programs
would be in use.

Q. How are the GroupWise gateways licensed?

A. The GroupWise gateway software is licensed on a per-installation
basis using the "loaded" and "stored" conditions previously described.
Each occurrence of each gateway installed must be licensed.

Q. Do I need multiple gateway licenses of any single gateway to service
the post offices and domains on my system?

A. Generally, one gateway per system will be sufficient to service the
needs of the entire system. If only one gateway is installed, it only needs
a single license and any user on the system can use its services.

Q. We tunnel through the Internet using the SMTP gateway. How
many SMTP gateway licenses are required?

A. One license is required for each installation of that gateway. To
connect two sites via gateway tunneling, two installed and licensed
gateways must be used.

Q. 4.1 versions of the GroupWise gateways now allow me to run
multiple gateway processes on a single defined gateway service. How
many licenses do I need to support this configuration?

A. Where two or more gateway processes are "loaded" and executing as
separate processes, each must be licensed.
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Starting GroupWise
This section provides information for installing GroupWise, formerly known as WordPerfect
Office, and GroupWise Remote on your Macintosh, Power Macintosh, or remote computer.
GroupWise includes an Installer utility to install the programs to System 7.x. However, you
must have System 7 Pro or higher in order to use the Drag and Drop feature. The
GroupWise files are compressed and cannot be used until you run the install program.

You should install the GroupWise Client software to the active startup disk. However, if
your diskspace is limited, you can run GroupWise from the network.

IMPORTANT: If you run GroupWise on a Power Macintosh, do not use the Energy Saver
and CPU Energy Saver control panels because they are incompatible with GroupWise.
You may want to discard these control panels by dragging them to the Macintosh system’s
Trash.

Macintosh Client
Station
Requirements

The requirements for running the Macintosh client on a network station are shown in the
table below.

Hardware/Software Minimum
Requirements

Recommended Requirements

Processor Macintosh II Macintosh IIci or better

System Version System 7 System 7 Pro or higher for drag
and drop and AOCE

Memory 2M available RAM 4M or more RAM

Hard drive 10.5M standard
install

12.5M complete install

Network Install 11M disk space 11M disk space

Installing the
GroupWise Client
Software

1 Make sure WP Office is not running.

2 Insert the Client 1 disk into your computer's disk drive.

or

Connect to the server volume on which the installation folder is located, then double-
click the folder containing the Installer and the program folders. Contact your system
administrator if you need to find out the location of the installation folder.

The installation program will detect your computer’s processor type and install a 68K
(standard Macintosh) or a Power Macintosh version of GroupWise to your machine.

3 Double-click the License Read Me, read it, then click the close box.

4 Double-click Install GroupWise, then click Continue.

5 If you currently have WP Office 4.0, read the compatibility notice. You should not
install the GroupWise 4.1 client if your system administrator has not yet installed 4.0a
or 4.1 administration software.

6 Click Continue when you’re done reading.

7 Click Install.

8 Use the directory dialog box to choose the location you will install to, type the name of
the folder to install to, then click Install.

9 If you are installing with disks, change disks as prompted by the install program.

10 A message will inform you if the installation was successful. Choose Quit.
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11 Open the Office 4.0 Items folder located in the folder you installed to. If it contains old
custom views that you want to use in GroupWise 4.1, move them to the
Languages:US:Custom Views folder, also located in the folder you installed to. After
you have moved your views, or if the Office 4.0 Items folder was empty, click the close
box and drag the Office 4.0 Items folder to the Trash.

12 Re-start your Macintosh.

Running
GroupWise from
the Network

You may want to run GroupWise from the network if you have limited hard disk space.
This network version of GroupWise recognizes your computer’s processor type and will
run either the 68K (standard Macintosh) or Power Macintosh version of GroupWise.
Check with your system administrator to see if you can install GroupWise from the
network. If you can, select Run GroupWise from Network in the custom install dialog
box.

If your system administrator has already installed GroupWise onto the network,

1 Connect to the appropriate server volume and folder where the GroupWise files are
located.

2 Double-click the Install GroupWise Workstation icon.

3 Use the directory dialog box to indicate the folder on your hard disk to install
GroupWise files to.

4 Click Install.

Logging In to
GroupWise

1 If you have not mounted the server where your post office is located, choose the n
menu, then choose Chooser.

If you don’t know which zone, server, or volume contains your post office, contact your
system administrator.

2 Click the AppleTalk zone where your post office is located, click AppleShare, then
double-click your post office file server.

3 Type your user ID and password for that server, then click OK.
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4 Select the correct server volume, then click the box to the right of the server name to
have the volume open each time you start your computer.

5 Click OK, then click the close box to close Chooser.

The mounted file server is placed on your System desktop. For more information about
Chooser, see your Macintosh user’s guide.

6 Double-click the GroupWise icon to start GroupWise.

7 Make sure Network is selected to log in to your network mailbox. See Using
GroupWise Remote later in this guide for instructions on how to log in to your remote
mailbox.

8 Click Post Office.

The directory dialog box lets you choose the folder the post office is located in. If you don't
know the location of your post office, contact your system administrator.

9 Click Desktop to list the mounted servers, then double-click the server that contains
your post office.

10 Continue double-clicking folders until you find the post office folder.

If you see files such as OFFILES, OFMSG, OFNOTIFY, and so forth, you have gone too
far. Use the directory title menu to close the current folder.

11 Click the folder that contains the GroupWise post office, then click Select.

12 Choose the User ID pop-up menu, then choose User ID or Network ID. You can log
in with your network ID, or with a user ID if your system administrator created one.

Starting GroupWise 15



13 Click Find.

14 Make sure Users is selected. You can type your name to search for it while you are in
the Users list box.

or

If you want to log in as a resource that you own, select Resources. You can also log
in as a resource later. See Resource in the GroupWise 4.1 for Macintosh Reference.

15 Select your name or the resource's name, then click OK.

16 If you have been assigned a password, type it in the Password box. If you want to set
a password later, see Environment Preferences in the GroupWise 4.1 for Macintosh
Reference.

Setting a mailbox password increases the security of your mailbox. In addition, you may
receive a routed item that requires your mailbox password before you can open it.

17 If you want to bypass the Log In dialog box in the future, select Log In at Startup.
However, if you don’t want people to easily access your mailbox, you would not select
this option.

18 Click Log In.

Your name appears in the
Main Window.

A Brief Tour
Welcome to GroupWise 4.1 for Macintosh! This section provides you with a quick
overview of GroupWise 4.1 and helps you get acquainted with this guide.

The Main Window With the intelligence of GroupWise, you now have the tools you need for electronic
messaging, as well as time and task management.
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The Main Window lets you open other windows to view your incoming and outgoing
messages, open calendar views for managing your schedule, and open item views for
sending mail, appointments, tasks, notes, and phone messages. You can access all the
following tools from the Main Window:

Proxy pop-up menu

Shelf pop-up menu

The Window pop-up menu lets
you open various windows.

Shelf

The pop-up menu lists the views
available for each tool.

Main Window

The In Box displays all incoming messages and requests. When your In Box icon
displays an envelope, that means there are new items to read and act on.

The Out Box displays all messages and requests you send. Use the Out Box to
retract items you have sent, or to find out if an item has been delivered, opened, accepted,
declined, deleted, and so forth.

When your Trash icon displays a full Trash, it means you have deleted items from
your Calendar, In Box, or Out Box. Until it is emptied, the Trash stores all your deleted
items, allowing you to recover an item if you change your mind.

The Calendar is a personal calendar and time management tool. There are several
predesigned calendar formats you can select from to manage your appointments, tasks,
and notes.

Electronic mail has never been more versatile. Besides sending a message with
Send Mail, you can also attach text files, graphics, applications, sounds, movies, and
GroupWise views.

Schedule is your personal and group appointment tool. People and resources (such
as conference rooms, company vehicles, and overhead projectors) can all be scheduled
for an event quickly and easily.

Assign Task can be used as a project management tool which makes organizing a
group effort as easy as identifying the tasks, people, and time frame needed to accomplish
the goal. You can also create a personal task list with this tool.

Write Note lets you post reminders, announcements, or requests for other users, as
well as create personal reminders for yourself. Use notes as reminders about upcoming
deadlines, holidays, and so forth.

Use Phone Message to send paperless phone or “While You Were Out” messages.

Shelf: Use the Shelf to customize GroupWise to your needs. You can place any icon
from the Main Window (except the Trash) or an application icon on the Shelf. The Shelf
icons let you open views, templates, proxied calendars, filtered boxes, and launch
applications quickly. See Shelf in the GroupWise 4.1 for Macintosh Reference or in online
Help.

Window Pop-Up Menu: Use the Window pop-up menu to access the Main Window
quickly. Use Iconize to reduce the currently selected window to an icon on your desktop.
To expand the icon into a view, double-click the icon. Use Hide to conceal a view or
window. You can access hidden windows by choosing the Window menu.

A Brief Tour 17



In Box and Out
Box Icons

The messages, appointments, or requests you send or receive are called items.

Items with accompanying attachments such as files or graphic documents are marked with
a paper clip icon in the In Box. An item with a sound annotation is marked with a speaker
icon. In addition, private items are marked with a padlock icon.

Paper clip icon

Speaker icon

Padlock icon

GroupWise Views A view lets you display information. GroupWise includes three types of views.

Group views let you send mail messages, appointments, tasks, notes, or phone messages
to one or more users, including yourself if you want.

Personal views let you place appointments, tasks, or notes which involve only you, into
your Calendar.

Calendar views display your scheduled items, the date they are scheduled for, and when
they are due. A calendar view can display your Appointments list, Tasks list, Notes list, a
monthly calendar, and incoming and outgoing items.

Using This Guide The User’s Guide is divided into two clear and simple sections to help you quickly learn the
tools of GroupWise:

Using GroupWise: Refer to this section when you need quick, how-to information on basic
tasks. The tasks are grouped according to the icons in the Main Window.

Using GroupWise Remote: Explore this section for information on how to use GroupWise
Remote to communicate and manage your time and business tasks when you are away
from the office.

Reference Manual Because of the power and flexibility of GroupWise, not all features or applications of the
program can be covered in this guide. By turning to the GroupWise 4.1 for Macintosh
Reference (subsequently referred to as the reference manual), you can find the answers
you will need about the specific features and functions of GroupWise.

Conventions Icons
Some of the icons in GroupWise are unnamed in the interface. An icon within a step
guides you to the icon you need to choose to perform the task. The following step shows
what you might see in the manual.

1 Choose Proxy , then choose the name of the user you want to proxy.

Bolded Words
Bolded words in steps or explanations indicate what you choose or select in the step. The
following step shows what you might see.

2 Choose the Edit menu, then choose Preferences.
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Getting Help
If you encounter problems using GroupWise, you can get help from several sources:

• Online Help
• The Manuals
• Your System Administrator or Help Desk
• Customer Support

Using Online Help Online Help gives you quick access to documentation without reaching for a manual. You
can access Help by using GroupWise Help and Balloon Help wherever you are in
GroupWise.

GroupWise Help
1 Choose the n menu, then choose GroupWise Help.

2 Select a topic from the list box.

3 Click the close box when you have finished using Help.

You can also leave the Help window open while you are working in GroupWise.

Balloon Help
Balloon Help defines screen elements and briefly tells you what they are used for.
GroupWise Balloon Help is fully compatible with System 7 Balloon Help.

1 Choose the Balloon Help menu, then choose Show Balloons.

2 Point to items on the screen to see Balloon Help on those items.

3 When you have finished using Balloon Help, choose the Balloon Help menu, then
choose Hide Balloons.

Other Assistance If you need assistance beyond what the Help features and the GroupWise manuals can
provide, contact your Help Desk or your system administrator. If they cannot solve your
problem, these individuals can contact Customer Support.
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Reading Items
All incoming items appear in your In Box. Item types include mail messages,
appointments, tasks, notes, and phone messages.

From the Main Window,

1 Double-click In Box .

2 Double-click the item you want to read in the Item list box.

Close box

Folder list box

Item list box

If you are reading all your items, you can choose the Actions menu, then choose Next to
read the next item or Previous to read the previous item.

3 Click Close when you are done.

4 Click the close box in the In Box to return to the Main Window.

Tips and Hints Item Priority
High priority items are red on color monitors. Low priority items are light gray.

Opening Several Items
You can select multiple items to read by Shift-clicking a continuous range of items, or c-
clicking non-continuous items. Choose the Actions menu, then choose Read. All the
selected items will open. Click the close box of each item you have finished reading.

Deleting Items Immediately
You can delete items immediately after reading them. Choose the Actions menu, then
choose Delete while you’re in the item view. See Deleting Incoming Items under In Box.

Access and Proxy Lists
You don’t have to leave your items unattended if you expect to be away from your office
for an extended period. You can selectively grant rights to another user, your proxy, to
answer your mail or other items. See Letting a Proxy Manage Your Mailbox (Access List)
under Sharing Mailboxes.

If you don’t want to give someone access to your In Box, you can create a rule that
forwards items to another user. See Rules in the reference manual.

Switching to a Standard View
If you receive an item that has a custom view, you can switch to a standard view by
holding down the Option key and double-clicking the item in the In Box.
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Reading Attachments
An attachment is a file which may contain text, graphics, applications, sounds, or movies,
and is sent with an item. In the In Box, items with attachments are marked with a paper
clip icon. Items with sound annotations are marked with a speaker icon.

The paper clip icon means the
item has an attached file.

The speaker icon means the
item has a sound annotation.

You can display an attached text file or WordPerfect document in the Message box. Other
types of attachments can be read by launching the application that created the file.

From the In Box,

1 Double-click the item with attachments to open the item view.

2 Double-click the attachment in the Attach box to view the contents of the attachment.

Click to return to the Item.

Double-click to view the
message.

Tips and Hints Items Without the Attach Box
You can include attachments with items that don’t have the Attach box. When you choose
a file to attach to the item, GroupWise places the file name in the Attachment pop-up
menu.
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The recipient can choose the Attachment pop-up menu, then choose the attachment to
view it.

Attachment pop-up menu

Attached file

Launching an Application
If the attachment can’t be displayed, choose the Attachment pop-up menu, then choose
Launch to view the attachment in the application that created it.

If you can’t launch the application that created the attachment, make sure you have the
application. If you have the application, you may need to specify the launch definition.
See Environment Preferences in the reference manual.

Viewing Attachments in the Message Box
To view an attachment in the Message box instead of a viewer window, hold down the
Option key and double-click the attachment in the Attach box.

Printing Items and Attachments
You can print incoming and outgoing items, and accompanying attachments.

Printing Items From the In Box or Out Box,

1 Select the item(s) you want to print.

or

Open the item you want to print.

2 Choose the File menu, then choose Print.
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Make sure Item is selected.

3 Select the Item options you want, then click OK.

4 Select the Print options you want, then click Print.

Printing
Attachments

From the In Box or Out Box,

1 Open the item that contains the attachment you want.

2 Double-click the attachment to display it in the viewer window.

3 Choose the File menu, then choose Print.

4 If you are prompted for page setup settings, choose the appropriate options, then click
OK.

5 Select your print options, then click Print.

Tips and Hints Page Setup and Print Options
Page Setup lets you select paper size and orientation, specify reduction, enlargement,
printer effects, and select other options. The standard Macintosh Print dialog box is part of
the Macintosh System and varies depending on the printer driver you select in Chooser.
For more information, see your Macintosh user’s guide or your system administrator.

Printing Attachments
If you want to retain all the formatting codes of an attachment, you may want to print the
attachment from the application it was created in. You can launch the attachment’s
application from the Attachment pop-up menu. See Environment Preferences in the
reference manual.

Accepting or Declining Appointments, Tasks, and
Notes

Accept or Decline lets you inform the sender of an appointment, task, or note whether you
are available or not. The text descriptions of these items remain italicized in your In Box
and Calendar until you have accepted or declined the items.
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From the In Box,

1 Double-click the item in the Item list box.

Appointment view

2 Click Accept or Decline .

3 If you accept, type any additional comments, then click Accept.
or

If you decline, type your reason for declining, then click Decline.

4 If the item is part of an auto-date definition, click All of Them to accept all occurrences,
or click Just One to accept only this occurrence. See Scheduling Recurring Items
under Schedule.

After accepting an appointment, task, or note, the italicized text will be changed to normal
text in your Calendar. Accepted items are filtered out of your In Box and appear in your
Calendar.

Tips and Hints Setting Alarms
If you are accepting an appointment, click Alarm Options, then make sure that Set Alarm
is selected. Select Early Notification or Notification at, select a time, then click OK.

To set alarms for accepted appointments in the Calendar, select the appointment you
want, choose the Actions menu, then choose Alarms.

Accepting or Declining from the Calendar
You can also accept or decline appointments, tasks, or notes from your Calendar. See
Accepting or Declining Appointments, Tasks, and Notes under My Calendar.

Replying to Appointments, Tasks, and Notes
While accepting or declining an appointment, task, or note, you’ll be prompted to type a
comment. Your comments will appear in the sender’s Info window. If the sender selected
Return Mail in her or his Preferences or Options settings, the sender will also receive your
comments in a mail message.

To reply before accepting or declining, choose the Actions menu, then choose Reply.
Continue with step 2.
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Where Items are Moved
When you accept an appointment, task, or note in your In Box, the accepted item is
displayed only in your Calendar. If you decline the item, it is moved to your Trash. You
can adjust the In Box Filter if you would like to see your accepted items in the In Box. See
Filter in the reference manual.

Undeleting
If you declined and deleted an item from your In Box or Calendar, you can still undelete
and accept the item if you have not emptied the Trash. See Undeleting Items under
Trash.

Replying to Mail and Phone Messages
After reading an item, the Reply feature lets you respond to the sender immediately
without having to select the sender’s name from the Address Book. You can also reply to
an appointment, task, or note. See Tips and Hints below.

From the item view,

1 Click Reply .

2 If you want to include the item’s text in your reply, select the Include Message Text
check box.

3 Click OK.

or

Select Reply to All, then click OK. See Tips and Hints below.

4 Type your reply in the Message box.

Close box

The To box is already
addressed to the sender of the
original item.

Message box

The Subject box contains the
original subject with “-Reply”
added to the end.

5 Click Send to send your reply.

6 Click Close in the original item to return to the In Box.

Tips and Hints Reply to All Recipients
When the same mail is sent to you and other users, you can send your reply to those
users as well as the original sender by choosing Reply to All.
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Resending a Message
If you want to resend basically the same message with minor changes, see Resending and
Rescheduling Items under Out Box.

Forwarding Items
When you want someone else to read the item you have just received, use Forward.
When you forward an item, it is sent as an attachment to a mail message.

From the In Box,

1 Double-click the item you want to forward.

2 Choose the Actions menu, then choose Forward to open a new mail view.

The subject remains the same
except that “-Forwarded” is
added to the end.

The item you want to forward
is in the Attach box.

3 Click Address to open the Address Book.

4 Select recipients for the Send To, Carbon Copy, and Blind Copy boxes by dragging the
recipients to the appropriate boxes.

5 Click OK.

6 Type a message in the Message box.

7 Click Send to forward the item.

Tips and Hints Delegate
If you are unable to accept an appointment, task, or note, delegate the request instead of
forwarding the item. Delegating will send a delegated status to the sender’s Info window.
This way, the sender will know that you have transferred the responsibility to another
person. See Delegate in the reference manual.

Attaching Files
If there are other files you want to send with the item you’re forwarding, use the Attach
feature. See Attaching Files under Send Mail.
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Deleting Incoming Items
You can delete any item from the In Box at any time. If you delete an appointment before
the appointment’s start time, GroupWise will send a Declined status to the sender. If you
delete an appointment after the start time, GroupWise will send a Deleted status to the
sender.

From the Main Window,

1 Double-click In Box .

2 Select the item you want to delete.

3 Choose the Actions menu, then choose Delete to move the item into the Trash.

Tips and Hints Selecting Multiple Items
You can also select multiple items to delete.

To select a continuous range of items, click the first item, then Shift-click the last item in
the range.

To select non-continuous multiple items, c-click the items you want to delete.

Undeleting
If an item has been deleted by mistake, it can still be recovered if you haven’t emptied the
Trash. See Undeleting Items under Trash.

Creating Folders
Folders help you to organize and store your In Box and Out Box items. You can use
folders to group items by a specific task, project, person, or any other subject.

All the folders that you create are subfolders of the root folder. The Folder list box
contains the same folders whether you are in the In Box or Out Box, and any folder can
contain subfolders in hierarchical levels.

Root folder

Folder list box

An arrow indicates the
presence of subfolders. Click
to open or close folders.

Subfolders

From your In Box or Out Box,

1 Select the folder you want the new folder to be nested in.

2 Choose the File menu, then choose New Folder.

3 Type the name of the new folder, then click OK.

A folder name should not exceed 240 characters.
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Tips and Hints Moving an Item to a Folder
Drag the item’s icon into the folder.

Linking an Item to Multiple Folders
Linking an item to a folder lets you view the item from more than one folder. For example,
if you have an item that relates to both Marketing and Personnel, you can place the item in
the Marketing folder, then link the item to the Personnel folder. You can then open the
item from either folder.

From the In Box or Out Box,

1 Open the folder containing the item.

2 Press the Option key and drag the item to another folder.

The item is linked to the new folder. You can link an item to as many folders as you want.

Moving a Folder
You can move any folder except the root folder. Drag the folder you want to move and
drop it into another folder.

Deleting Folders
To delete an unwanted folder and its contents, select the folder, choose the Actions
menu, then choose Delete. Select a deletion option, then click OK.

When you select Folders Only,
the contents in the folder are
placed in the root folder.

You cannot delete a folder that is used in a rule. First delete or modify the rule, then
delete the folder. See Rules in the reference manual.
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Resending and Rescheduling Items
You can resend mail or phone messages, or reschedule appointments, tasks, and notes if
they are still in your Out Box. You may also want to retract the original item before
resending it. See Retracting Unopened Items under Out Box.

From the Main Window,

1 Double-click Out Box .

2 Select the item to resend or reschedule, choose the Actions menu, then choose Read.

3 Make any necessary change.

You can change the addresses, subject, message, start and end times, options, and so
forth.

4 Click Send .

You will be prompted to retract the original item. Mail, notes, and phone messages cannot
be retracted if they have already been opened by the recipient(s). Appointments and tasks
can be retracted at any time, even after they have been accepted.

5 Click Retract to retract the original item.

or

Click Don’t Retract to keep the original item and send the revised item.

6 Click the close box to return to the Main Window.

Tips and Hints Rescheduling from Your Calendar
You can also reschedule your Calendar items. To reschedule from your Calendar, see
Rescheduling Appointments, Tasks, and Notes under My Calendar.

Finding an Item
If you’re having trouble searching for an item in a long list in your Out Box, choose the Edit
menu, then choose Find.

Type the text that matches the text in the item’s Subject, Date, Type or From boxes, then
click Find.

If you want to search other fields, choose More Choices, select your search conditions,
type the search text, then choose Find.

Type your search text here.
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Retracting Unopened Items
If the information in an item has become outdated or is incorrect, you can retract the item.
Mail, notes, and phone messages can be retracted if the recipient has not opened them.
Appointments and tasks can be retracted anytime, even after they have been accepted.

From the Main Window,

1 Double-click Out Box .

2 Select the item you want to retract.

or

If you’re retracting a mail message, note, or phone message, double-click the item you
want to retract, then check if your item has been opened. Click the close box when
you’re done checking .

If there is no Opened status information next to the user ID, the mail message, note, or
phone message has not been opened, and you can still retract the item.

Delivery information

Opened date and time
information

Info window

3 Choose the Actions menu, then choose Delete.

4 Select All In Boxes to retract from all recipients’ In Boxes only.

or

Select All Mailboxes to retract from your Out Box and all recipients’ In Boxes.

5 Click OK to retract the item.

6 Click the close box to return to the Main Window.
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Tips and Hints If Resending or Rescheduling
If you plan to resend or reschedule an item, you may choose to retract from All In Boxes.
This way, you can edit the item from your Out Box without creating a new item.

Sorting Items by Date
If you are having difficulty distinguishing between the original and the resent items in your
Out Box or In Box, sort the items by Date. See Sorting In Box Items under In Box or
Sorting Out Box Items under Out Box.

Deleting Outgoing Items
To free up disk space, you should periodically delete obsolete or unwanted items from
your Out Box.

From the Main Window,

1 Double-click Out Box .

2 Select the item you want to delete.

3 Choose the Actions menu, then choose Delete.

4 Click OK to delete the item from This Out Box and move the item into the Trash.

Delete from your Out Box only

Delete from all recipients’ In
Boxes

Delete from your Out Box and
recipients’ In Boxes

5 Click the close box to return to the Main Window.

Tips and Hints Selecting Multiple Items
You can also select multiple items to delete.

To select a continuous range of items, click the first item, then Shift-click the last item in
the range.

To select non-continuous multiple items, c-click the items you want to delete.

Automatic Cleanup Preferences
You can also use the Cleanup Preferences to have GroupWise automatically delete items
from your mailbox.

1 Choose the Edit menu, then choose Preferences.

2 Click Cleanup in the icon list box.

3 Select Automatic Delete from the Mail and Phone and Appointment, Task, and
Note group boxes.

4 Type the number of days you want to keep the items, then click OK.
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Undeleting
If an item has been deleted by mistake, you can still recover it if you haven’t emptied the
Trash. See Undeleting Items under Trash.

Tracking Item Information
From the Out Box, you can find out what actions have been performed on the items you’ve
sent.

For example, when a recipient opens an item from you, forwards the item to a GroupWise
user, then delegates the item to another user, GroupWise will inform you of these three
actions and when they occurred, if you were the original sender.

From the Main Window,

1 Double-click Out Box .

2 Double-click an item to view its status information.

Close box

List of recipients

Opened date and time
information

Displays the full recipient names.

Delivery date and time
information

Deletion date and time
information

Info window

3 Click the close box to return to the Out Box.

4 Click the close box to return to the Main Window.

Tips and Hints Accessing the Info Window Elsewhere
You can also access the Info window from within an item. After opening the item, choose
the Actions menu, then choose Get Info.

Status Information Preferences
You can keep track of your items and choose the types of information you want to know
about them.

1 Choose the Edit menu, then choose Preferences.

2 Make sure Send is selected from the icon list box, and the Send pop-up menu shows
Universal Settings.

3 Select the desired options from the Status Information group box.
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Select an item type if you want that item type to receive different status information.

Resending
If a recipient has mistakenly deleted an item without replying, you can resend the item.
See Resending and Rescheduling Items under Out Box.

Undeleting Items
You can still recover items you have deleted from your Calendar, In Box, and Out Box if
they have not been emptied from the Trash.

From the Main Window,

1 Double-click Trash .

2 Select the item(s) to undelete.

3 Choose the Actions menu, then choose Undelete to recover the item.

4 Click the close box to return to the Main Window.

Tips and Hints Where Undeleted Items Appear
An undeleted item will reappear in the In Box and Out Box folder it was deleted from. If the
folder the item was deleted from no longer exists, the undeleted items will reappear in the
root folder.

Emptying Your Trash
Emptying your Trash lets you permanently delete all the items currently in your Trash.
Once you have emptied your Trash, you will not be able to recover any items.

Emptying Selected Items
From the Main Window,

1 Double-click Trash , then select the item(s) you want to empty.

2 Choose the Edit menu, then choose Empty Selected Items.

Emptying All Items
From the Main Window,

1 Choose the Edit menu, then choose Empty Trash.

2 Click OK to confirm that you want to delete all items.

Tips and Hints Selecting Multiple Items
To select a continuous range of items, click the first item, then Shift-click the last item in
the range.

To select non-continuous multiple items, c-click the items you want to delete.
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Automatic Cleanup
When requested, GroupWise will automatically empty your Trash in a specified number of
days.

1 Choose the Edit menu, then choose Preferences.

2 Click Cleanup in the icon list box, then select Automatic Empty Trash from the Empty
Items in Trash group box.

3 Type the number of days in the days box. A 0 setting will empty your Trash each time
you quit GroupWise.

Be aware that your system administrator can set and lock this option.

Accepting or Declining Appointments, Tasks, and
Notes

Use Calendar to manage your personal schedule and business tasks. You can read and
respond to any incoming requests from your Calendar. When you accept or decline an
item, GroupWise places an accepted or declined status in the sender’s Info window. See
Tracking Item Information under Out Box.

From the Main Window,

1 Choose the My Calendar pop-up menu, then choose a calendar view.

Close box

Appointments list box

Italicized descriptions mean
that you have not yet accepted
or declined the item.

Notes list box

Tasks list box

Day View

2 Double-click the text of the desired item in the Appointments, Tasks, or Notes list box
to open the appropriate item.

3 Click Accept or Decline .

4 If you accept, you may type additional comments, click Alarm Options to select the
date and time you want to be notified, click OK, then click Accept.
or

If you decline, you may type your reason for declining, then click Decline.

5 Click the close box to return to the Main Window.
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Tips and Hints Expanding a Box
You can expand the Message box to fill the entire view of any item. In addition, you can
expand the Appointments, Tasks, or Notes list box to fill the entire calendar view.

The Appointments list box is
expanded in the Day view.

To expand a box, choose the Edit menu, then choose Expand. You can also hold down
Option-c and click the list box. To restore the calendar view, hold down Option-c and
click the box again.

Rescheduling Appointments, Tasks, and Notes
You can reschedule a group item from the Calendar if you were the original sender of that
item. You cannot reschedule an item if someone else scheduled it. You may also retract
the original item before rescheduling it. See Retracting Unopened Items under Out Box.

From the Main Window,

1 Choose the My Calendar pop-up menu, then choose the Day calendar view.

Close box

Monthly Calendar

You can drag the ending time to
change an appointment length.

Day View

2 Click the appropriate list box, then select the item you want to reschedule.

or

To reschedule an item scheduled on a different day, select the item’s currently
scheduled date from the Monthly Calendar, then click the appropriate list box, and
select the item you want to reschedule.
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3 Drag the item to the new date in the Monthly Calendar.

Click to move one month
forward or backward.

Click to move one year
forward or backward.

If you need to reschedule the item for a different month or year, click the arrows in the
Monthly Calendar.

4 To change the time of an appointment, drag the item to a different time in the
Appointments list box.

If you are rescheduling a group item, a dialog box opens asking if you want to edit the item
before rescheduling. Click Edit to open the item view or Don’t Edit to reschedule the
item. The recipients can accept or decline the new time.

5 Click the close box to return to the Main Window.

Tips and Hints Changing the Length of an Appointment
You can change the duration of an appointment (for example, from one hour to two hours)
in the Appointments list box. Select the appointment, then drag the ending time to the
appropriate end time.

Completing Tasks and Routed Items
Tasks that have not been marked as completed will be carried over to the next day on your
Calendar. In addition, overdue tasks turn red if they are not marked completed.
Completed tasks are distinguished by a check mark in your Calendar.

Routed tasks and routed mail also need to be marked completed before they are sent to
the next person. See Routing Slips in the reference manual.
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From the Main Window,

1 Choose the My Calendar pop-up menu, then choose a calendar view that shows your
Tasks list.

List Type menu

Calendar list box
Uncompleted Task

Completed Task

Week View

2 If the Calendar list box does not display tasks, click the Calendar list box, choose the
List Type menu, then choose Tasks.

3 Click the check box next to the task.

A check mark appears in the task’s check box.

Tips and Hints From a Task or Routed Item View
You can also mark a task or a routed item as completed from within the item view by
selecting the Completed box.

Completed box

Sender Notification
If another user assigned the task to you and chose in Preferences to be notified upon
completion, GroupWise will notify the sender when you mark the task completed. See
Send Preferences in the reference manual.

In addition, a completed status, including the date and time the task was marked
completed, is placed in the sender’s Info window. See Tracking Item Information under
Out Box.

Declining After You have Accepted
If an unexpected event prevents you from completing a task you accepted, you can decline
the task and include a reply. See Accepting or Declining Appointments, Tasks, and Notes
under My Calendar.
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Unmarking a Task
If you accidentally marked the wrong task as completed, you can “uncomplete” the task by
clicking the Completed box again.

Printing Your Calendar
To help you manage your schedule and tasks, GroupWise lets you print Calendar items in
a list format or in a variety of planner forms.

Printing Calendar
Items

You can print a list of appointments, tasks, or notes.

1 Choose the File menu, then choose Print.

2 Select Calendar Items, then select an item type.

Click to specify the starting
date

Specify the number of days,
weeks, or months

3 Specify the Date Range, then click OK.

4 Select the print options you want, then click Print.

Printing Calendar
Forms

You can print your Calendar in a variety of planner forms.

1 Choose the File menu, then choose Print.

2 Select Calendar, then select a form.

Click to specify the starting
date

Shows what the form looks like

Specify the number of days,
weeks, or months

If you want to include the calendar items of people you are proxying for, make sure those
user names are in your proxy list before selecting Include Proxies or the Proxy form.
See Letting a Proxy Manage Your Mailbox under Sharing Mailboxes.

3 Specify the Date Range, then click OK.
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4 Select the print options you want, then click Print.

Tips and Hints Page Setup
Page Setup lets you set up the printer correctly. Choose File, then choose Page Setup to
select your paper size and orientation, specify reduction or enlargement, printer effects,
and other options.

Selecting the Right Printer
If nothing prints, make sure you have selected the right printer with Chooser.

Sending Mail
You can attach files and sounds to the mail you send to other GroupWise users. See
Attaching Files under Send Mail.

From the Main Window,

1 Choose the Send Mail pop-up menu, then choose a mail view.

Lets you include sounds in
an item

Lets you select another user
to proxy for

Lets you switch to another
mail or item view

Attachment menu

Private check box

Address boxes

Mail view

2 Click Address to open the Address Book.

3 Drag the user IDs to the Send To, Carbon Copy, and Blind Copy boxes, then click OK.

4 Type the subject in the Subject box.

5 Type a message in the Message box.

6 Click Send to send the mail message to the recipients’ In Boxes and to your Out
Box.

Tips and Hints Typing the Recipient’s ID
Instead of using the Address Book to enter user IDs in the address boxes, you can type
the user IDs. The following rules apply:

• You must spell user IDs correctly.
• You must separate user IDs with commas.
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Personal Groups
To send an item to a personal group, choose in the Address Book, choose Personal
Groups, then double-click the group you want to send the item to. See Creating
Personal Groups under Send Mail.

Attaching Files
You can attach folders, text files, graphics, applications, sound files, and movies with any
item you send.

From any new item view,

1 Choose , then choose Files.

Use the Attachment menu to
attach files.

Use the Sounds menu to include
sounds.

2 Use the directory list box to locate the files or applications you want to include with the
item.

3 Double-click the files to place them in the Items to Attach box, then click Done to
attach the files to the item.

The files appear as icons in the Attach box unless you choose View by Name in the
Attachment menu.

Attachment menu

Attached files
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Tips and Hints Drag and Drop
If you’re using System 7 Pro or later, you can drag the attachments to the desktop folder
you want to save the file in.

Attachments and Routing Slips
You can use Routing Slip to send an attachment sequentially to several users. The users
can open the attachment, make changes to it, then route it to the next user. See Routing
Slips in the reference manual.

Including Attachments without an Attach Box
If you are including attachments with an item that does not have an Attach box,
GroupWise places the file name in the Attachment menu. The user can choose the
Attachment menu to view the attachment.

Creating Personal Groups
You can create your own groups of users and resources to address mail messages,
appointments, tasks, notes, and phone messages. Creating a personal group is similar
to giving a nickname to one or more users.

For example, if you often need to schedule meetings for the same group of people,
create a personal group instead of selecting the people individually from the Address
Book each time you schedule a meeting.

From the Main Window,

1 Choose the Tools menu, then choose Address Book.

2 Drag the names you want to the Send To, Carbon Copy, and Blind Copy boxes.

Include your name if you want to be a member of the group.

3 If you want to include resources, choose , choose Resources, then double-click the
resources you want.

Lists users, resources, public
groups, or personal groups

4 Click Save Group, type a name for the group, then click OK.

5 Click Cancel to return to the Main Window.
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Tips and Hints Saving a Personal Group
If someone sends you an item addressed to a group you would like to copy and save for
your own use, GroupWise lets you save the group without having to select each
individual. In addition, if you sent items to users that you have not yet defined as a
group, you can save the group later, if you still have the sent item.

To save a personal group, open the item that is addressed to the individuals you want in
a group. Choose the Actions menu, then choose Save As Group. Type the name of
the group, then click OK.

Public Groups
Public groups are created by the system administrator for every user to access. Only the
system administrator can change, delete, or add public groups.

Editing Names in a Personal Group
You can edit the list of names defined for a personal group you have created.

From the Address Book,

1 Choose , then choose Personal Groups to display the groups you have saved.

2 Select the group to change, then click Retrieve Group.

3 Choose , then choose Users to display the User list.

4 To remove a name, drag the user icon from the Send To, Carbon Copy, or Blind Copy
box to the Users list.

or

To add a name, drag the user icon from the Users list to the Send To, Carbon Copy, or
Blind Copy box.

5 Click Save Group, type the group name, then click OK.

6 Click OK to return to the Main Window.

Setting Temporary Mail Options
With Options, you can change the following for the mail message you are currently
sending.

Options Purpose
Priority Controls the appearance and sound notification of the mail

message in the In Box and Out Box, so that the priority of the
item is apparent to the receiver

Status Information Monitors the actions performed on your mail

Expires Deletes mail from all recipients’ In Boxes who have not yet
opened the mail after a number of days

Reply Requested Asks recipients to reply to your mail within the number of days
specified

Return Receipt Alerts you each time a recipient opens, deletes, or completes
the mail
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Options Purpose
Mail Options/
Auto-Delete

Deletes the mail from your Out Box and empties it from the
Trash, as soon as all recipients delete the mail from their In
Boxes and empty it from their Trash

Mail Options/
Notify Recipients

Alerts recipients with a sound, a dialog box, or a small icon, if
their notification preferences is turned on

From a new mail view,

1 Choose the Edit menu, then choose Options to open the Preferences dialog box.

2 Make sure Send is selected in the icon list box, and Mail is selected in the Send pop-
up menu.

Icon list box
Send pop-up menu

Priority group box

3 Select the options you want.

4 Choose OK to save the settings and return to the Mail view.

Tips and Hints High Priority
When you have a high priority item and want to alert the recipient, select High in the
Priority group box. The item will appear red in the recipient’s In Box if the recipient has a
color monitor.

Send Preferences
If you want to permanently select an option, instead of setting temporary options every
time you send an item, see Send Preferences in the reference manual.

Scheduling Meetings
A meeting or group appointment can be scheduled for yourself and one or more
GroupWise users.

From the Main Window,
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1 Choose the Schedule pop-up menu, then choose a meeting view.

2 Click Address to open the Address Book.

3 Select the participants for the Send To, Carbon Copy, and Blind Copy boxes by
dragging the participants to the appropriate boxes.

Include your name if you are also a participant.

4 If you need to include resources, choose , choose Resources, then double-click
the resources.

Resources (for example, conference rooms, projectors, and company vehicles) are
defined by your system administrator. If you select a location that your system
administrator has defined as a place, the resource will appear in the Place box when you
tab to it. Other types of resources will appear in the To box along with the participant
names.

5 Click OK

6 If the meeting place is not listed as a resource, type it in the Place box in the Meeting
view.

7 Type the subject in the Subject box.

8 Type a message in the Message box.
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9 Click Start Date , select the meeting date and time, then click OK.

Click to move one month
forward or backward.

Click to move on year
backward or forward.

Selected date

Drag the start time pointer to the
start time.

Drag the end time pointer to the
end time.

Selected time

10 Click Send .

Tips and Hints Auto-Date
Scheduling recurring appointments is quick and easy when you use Auto-Date. See
Scheduling Recurring Items (Auto-Date) under Schedule.

Busy Search
To find out what days and times are available for all participants and resources, use Busy
Search. See Using Busy Search under Schedule.

Personal Groups
To send an item to a personal group, choose in the Address Book, choose Personal
Groups then double-click the group you want to send the item to. See Creating Personal
Groups under Send Mail.

Scheduling from the Calendar
To schedule a meeting from a calendar view,

1 Double-click the desired time in the Appointments list box.

2 Choose , then choose Meeting or Meeting w/ attach.

3 Complete your item, then choose Send .

Scheduling Personal Appointments
Create a personal appointment to help you manage your schedule. For example, you
may want to create a personal appointment to remind you of meeting at a client’s office.

The item is placed only in your Calendar, not in your In Box or Out Box or in any other
person’s In Box.

From the Main Window,
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1 Choose the Schedule pop-up menu, then choose Personal Appointment.

2 Type the subject in the Subject box.

3 Type the location in the Place box.

4 Type a message in the Message box.

5 Click Start Date , select the appointment date and time, then click OK.

Click to move one month
forward or backward.

Click to move one year
forward or backward.

Selected date and time

Drag the start time pointer to the
start time.

Drag the end time pointer to the
end time.

6 Click OK.

Tips and Hints Scheduling from the Calendar
To schedule a meeting from a calendar view,

1 Double-click the desired time in the Appointments list box to open a personal
appointment.

2 Complete your item, then click OK .

Auto-Date
You can schedule a recurring appointment using Auto-Date. See Scheduling Recurring
Items (Auto-Date) under Schedule.

Rescheduling
If your plans change, you can reschedule a personal appointment. See Rescheduling
Appointments, Tasks, and Notes under My Calendar.
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Using Busy Search
Instead of scheduling a meeting and having someone decline your request because of a
time conflict, Busy Search lets you search for free times to schedule appointments.

From the Main Window,

1 Choose the Schedule pop-up menu, then choose a meeting view.

2 Click the Address Book , select the meeting participants and resources, then click
OK. See Scheduling Meetings under Schedule.

3 Click Busy? .

Click the numbers and arrows
to change the meeting
duration by hours and
minutes.

Lets you see a participant’s
appointment information, if
you have access rights.

Click the numbers to change the
Search Range.

The current days to search are
Monday through Friday.

4 Select your search options, then click Search.

5 If you want to discontinue the search, click Stop.

Click the arrows to go to
another day.

Individual schedules

Shaded time intervals

Click the scroll arrows
to go to another time of
day.

If your Busy window shows a shaded participant name, it means the search is not
completed yet.

An “i” next to a user’s name means you can double-click the user’s busy times to see the
appointment information for that user.

6 Select the meeting date, double-click the start time you want, then complete and send
the item.

Tips and Hints Free Blocks Mode
The Free Blocks mode lists times the participants are simultaneously free over several
days. From the Busy dialog box, click Free Blocks to change from the Users mode.
Double-click the free block you want.

The meeting start time is the same as the start time of the free block, but the meeting
length will depend on the Duration you select. For example, if you double-click 8am-1pm,
but your meeting length is only one hour, your meeting will be scheduled from 8am-9am.
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Busy Search Preferences
You can set the duration, time, and days to search, as well as alter the Busy Search
display by using the Busy Search Preferences. See Conflicts Preferences in the
reference manual.

1 Choose the Edit menu, choose Preferences, then click Conflicts in the icon list box.

2 Choose the options you want, then click OK.

Scheduling Recurring Items (Auto-Date)

You can schedule recurring appointments, tasks, or notes by using Auto-Date. There are
three Auto-Date creation methods:

• By Example lets you define items that recur on days of the month, days of the week, or
periodically (for example, a meeting that is scheduled on every month’s first Tuesday).

• By Formula lets you use previous WP Office 3.x functions to describe recurring dates.

• By Dates accommodates items that recur on an irregular basis (for example, events
that occur on specific holidays for several years).

Only the steps using the By Dates mode will be covered in this task. See Auto-Date in
the reference manual for more information on the other methods.

From a new appointment, task, or note view,

1 Choose the Actions menu, then choose Auto-Date.

2 Choose the Creation Method pop-up menu, then choose By Dates.

Scrolls to the next year

3 Select the dates that apply.

4 Click OK, then complete and send the item.

Tips and Hints Selecting a Range of Dates
You can click and drag to select a range of dates. For example, if you want to select all
the Mondays of a specific month, click your pointer on the first Monday of the month and
drag to the last Monday.
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Clearing Date Selections
If you made a mistake and need to start over in scheduling your Auto-Dates, click Clear
from the Auto-Date dialog box, click Yes, then start again.

Setting Temporary Appointment Options
With Options, you can change the following for the appointment you are currently
sending.

Options Purpose
Appointment Priority Controls the appearance of the appointment in the In

Box and Out Box, so that the priority of the item is
apparent to the receiver

Status Information Monitors the actions performed on your appointment

Event Length Defines the time frame as a Duration or an End Date

Return Receipt Alerts you each time a recipient opens, accepts, or
declines the appointment

Appointment Options/
Default Length for an
Appointment

Sets the initial duration for a new appointment view

Appointment Options/
Notify Recipients

Alerts recipients with a sound, a dialog box, or a small
icon

From a new meeting view,

1 Choose the Edit menu, then choose Options to open the Options dialog box.

2 Make sure Send is selected in the icon list box, and Appointment is selected in the
Send pop-up list.

Icon list box

Send pop-up menu

Appointment Priority group box

3 Select the options you want.

4 Choose OK to save the settings and return to the appointment view.

Tips and Hints High Priority
When you have a high priority item and want to alert the recipient, select High in the
Appointment Priority group box. The item will appear red in the recipient’s In Box if the
recipient has a color monitor.
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Send Preferences
If you want to select an option permanently, instead of setting temporary options every
time you send an item, see Send Preferences in the reference manual.

Assigning Tasks
Organizing a group effort with GroupWise is as easy as selecting your recipients, a time
frame, and sending the request.

Tasks will be carried forward each day in the Calendar until they are marked completed.
Overdue tasks turn red if you have a color monitor.

From the Main Window,

1 Choose the Assign Task pop-up menu, then choose a task view.

Click the Private check box to
keep your proxies from reading
the item.

2 Click Address to open the Address Book.

3 Select the recipients for the Send To, Carbon Copy, and Blind Copy boxes by
dragging the icons of the recipients to the appropriate boxes.

Include your name if you are also a participant.

4 Click OK.

5 Type the subject in the Subject box.

6 Type a message in the Message box.

7 Click Start Date , select the start date, then click OK.

Click to display another month
or year.
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8 Click Due On , select the due date, and then click OK.

9 Click Send .

The task will be sent to the recipients’ Calendars and In Boxes, and your Out Box. The
task will also appear in your Calendar if your name is included in one of the address
boxes.

Tips and Hints Priority
You may assign a priority to the task, although it is optional. The task priority may consist
of a character followed by a number (from 0 through 999). The following are acceptable
formats: A1, C2, B, 3, and so forth.

In addition, you can change the item’s priority to High, Normal, or Low. See Setting
Temporary Task Options under Assign Task.

Auto-Date
Scheduling recurring items is quick and easy when you use Auto-Date. See Scheduling
Recurring Items (Auto-Date) under Schedule.

Personal Groups
If you often communicate with the same group of people, instead of selecting each of
their names from the Address Book, you can create a personal group. See Creating
Personal Groups under Send Mail.

Resending or Retracting
If plans change and you need to reschedule a task which you assigned to other users,
see Resending and Rescheduling Items under Out Box. You may also retract the task.
See Retracting Unopened Items under Out Box.

Creating Personal Tasks
Personal Task lets you create a personal task list in your Calendar to keep track of things
you need to do. The tasks will be carried over each day on your Tasks list until you mark
them completed. They will also turn red after the due date.

From the Main Window,

1 Choose the Assign Task pop-up menu, then choose Personal Task.

Click the Private check box to
keep your proxies from reading
the item.

2 Type the subject in the Subject box.
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3 Type a message in the Message box.

The default start date is today.

4 If you want another start date, click Start Date , select the start date, then click OK.

Click to display another month
or year.

The default due date is today.

5 If you want another due date, click Due On , select the due date, then click OK.

6 Click OK to add the item to your Tasks list in the Calendar.

Tips and Hints Priority
You may assign a priority to a task, although it is optional. The task priority may consist
of a character followed by a number (from 0 through 999). The following are acceptable
formats: A1, C2, B, 3, and so forth.

In addition, you can also change the item’s priority to High, Normal, or Low. See Setting
Temporary Task Options under Assign Task.

Auto-Date
You can schedule a recurring task using Auto-Date. See Scheduling Recurring Items
(Auto-Date) under Schedule.

Rescheduling a Personal Task
If you need to reschedule a personal task for another day, see Rescheduling
Appointments, Tasks, and Notes under My Calendar.

Setting Temporary Task Options
With Options, you can change the following for the task you are currently sending.

Options Purpose

Task Priority Controls the appearance of the task in the In Box and Out
Box, so that the priority of the item is apparent to the
receiver

Status Information Monitors the actions performed on your task

Define Event Length Defines the time frame or the due date mode

Return Receipt Alerts you each time a recipient opens, accepts, completes,
or deletes the task
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Options Purpose
Task Options/Notify
Recipients

Alerts recipients with a sound, a dialog box, or a small icon

From a new task view,

1 Choose the Edit menu, then choose Options to open the Options dialog box.

2 Make sure Send is selected in the icon list box, and Task is selected in the Send pop-
up menu.

Task Priority group box

Send pop-up menu

3 Select the options you want.

4 Choose OK to save the settings and return to the task view.

Tips and Hints High Priority
When you have a high priority item and want to alert the recipient, select High in the
Task Priority group box. The item will appear red in the recipient’s In Box if the recipient
has a color monitor.

Send Preferences
If you want to permanently select an option, instead of setting temporary options every
time you send an item, see Send Preferences in the reference manual.
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Sending Notes
A note is a message or reminder that can be scheduled for a specific day for you or one or
more GroupWise users. For example, you may want a note to appear as a reminder on a
birthday, upcoming deadline, holiday, and so forth.

From the Main Window,

1 Choose the Write Note pop-up menu, then choose a Notice view.

2 Click Address to open the Address Book.

3 Select the recipients for the Send To, Carbon Copy, and Blind Copy boxes by dragging
the recipients to the appropriate boxes, then click the close box.

Include your name if you want the note to be sent to your Calendar and In Box.

4 Type the subject in the Subject box.

5 Type a message in the Message box.

6 Click Start Date , select the start date you want, then click OK.

7 Click Send .

Tips and Hints Auto-Date
You can create recurring notes by using Auto-Date. See Scheduling Recurring Items
(Auto-Date) under Schedule.

Personal Groups
To send the item to a personal group, choose in the Address Book, then choose
Personal Groups. Double-click the group you want to send the item to, then click OK.
See Creating Personal Groups under Send Mail.

Rescheduling Notes
If your dates change, you can reschedule a note. See Rescheduling Appointments, Tasks,
and Notes under My Calendar.

Creating Personal Notes
Use Personal Notes to create a personal reminder for a specific date, such as a birthday,
upcoming deadline, or holiday.
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From the Main Window,

1 Choose the Write Note pop-up menu, then choose Personal Note.

Private check box

2 Type the subject in the Subject box.

3 Type a message in the Message box.

4 Click Start Date , select the start date you want, then click OK.

5 Click OK to place the note in your Notes list in the Calendar.

Tips and Hints Auto-Date
You can also create recurring notes by using Auto-Date. See Scheduling Recurring Items
(Auto-Date) under Schedule.

Keeping a Note Private
If you want to keep your proxies from reading a note, click the Private check box when you
create or receive a note.

Rescheduling Personal Notes
If dates change, you can reschedule your note. See Rescheduling Appointments, Tasks,
and Notes under My Calendar.

Setting Temporary Note Options
With Options, you can change the following for the note you are currently sending.

Options Purpose

Note Priority Controls the appearance of the note in the In Box and Out
Box, so that the priority of the item is apparent to the receiver

Status Information Monitors the actions performed on your note

Return Receipt Alerts you each time a recipient opens or deletes a note

Note Options/Notify
Recipients

Alerts recipients with a sound, a dialog box, or a small icon, if
they have loaded the Notify program

From a new note view,

1 Choose the Edit menu, then choose Options to open the Options dialog box.
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2 Make sure Send is selected in the icon list box, and Note is selected in the Send pop-
up menu.

Icon list box

Send pop-up menu

Note Priority group box

3 Select the options you want.

4 Click OK to save the settings and return to the item.

Tips and Hints High Priority
When you have a high priority item and want to alert the recipient, select High in the Note
Priority group box. The item will appear red in the recipient’s In Box if the recipient has a
color monitor.

Send Preferences
If you want to permanently select an option, instead of setting temporary options every
time you send an item, see Send Preferences in the reference manual.

Sending Phone Messages
Leaving a message about a phone call or office visit is now easy and paperless. The
Phone Message view resembles the information on a standard phone message pad.

From the Main Window,

1 Choose the Phone Message pop-up menu, then choose a phone message view.

Caller information boxes Message check boxes

2 Click Address to open the Address Book.

3 Double-click the names you want, then click OK.
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4 Type the caller information in the Caller, Company, and Phone boxes.

5 Click the appropriate message check boxes.

6 Type a message in the Message box.

7 Click Send to place the phone message in the recipients’ In Boxes and your Out
Box.

Setting Temporary Phone Options
With Options, you can change the following for the phone message you are currently
sending.

Options Purpose
Priority Controls the appearance of the phone message in the In Box

and Out Box, so that the priority of the item is apparent to the
receiver

Status Information Monitors the actions performed on your phone message

Reply Requested Asks recipients to reply to your phone message within the
number of days specified

Expires Deletes phone message from all recipients’ In Boxes who
have not yet opened the message after a number of days

Return Receipt Alerts you each time a recipient opens, completes, or deletes
the phone message

Mail Options/
Auto-Delete

Deletes the phone message from your Out Box and empties it
from the Trash, as soon as all recipients delete the message
from their In Boxes and empty it from their Trash

Mail Options/
Notify Recipients

Alerts recipients with a sound, a dialog box, or a small icon

From a new phone message view,

1 Choose the Edit menu, then choose Options to open the Options dialog box.

2 Make sure Send is selected in the icon list box, and Mail is selected in the Send pop-
up menu.

Icon list box

Send pop-up menu

Priority group box

3 Select the options you want.

4 Choose OK to save the settings and return to the item.
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Tips and Hints High Priority
When you have a high priority item and want to alert the recipient, select High in the
Priority group box. The item will appear red in the recipient’s In Box if the recipient has a
color monitor.

Send Preferences
If you want to permanently select an option, instead of setting temporary options every
time you send an item, see Send Preferences in the reference manual.

Managing Another User’s Mailbox
Proxies can receive and send items for other people. When you are selected as a proxy
on someone’s Access List, you can respond or act on that person’s behalf by accessing
the Proxy List.

Before you can proxy for others, you need to add their names in your Proxy List.

Adding a User to
Your Proxy List

From the Main Window, In Box, Out Box, or any item or calendar view,

1 Choose , then choose Proxy.

Lets you select a user to proxy
or return to your own view

The current view or window
belongs to the name on the status
bar.

2 Click Find, select the user’s name in the list box, then click OK.

3 Click Proxy at Startup if you want to act as a proxy for this user whenever you start
GroupWise.

4 Click Proxy.

Acting as a Proxy From the In Box, Out Box, or any item or calendar view,

1 Choose , then choose the user for whom you want to act as a proxy.

The view or window you have opened will now reflect the user’s view or window. The
name on the status bar is changed from your name to the other user’s name.

Tips and Hints Returning to Your Own Mailbox
To change the current view back to your own after acting as proxy for someone,

1 Choose , then choose your name.

Your name should now appear on the status bar.

If Access Is Denied
If you tried to add a new user to your Proxy List, but a message appeared informing you
that you do not have proxy rights for this user, check to make sure you are on the user’s
Access List.
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Letting a Proxy Manage Your Mailbox
Your proxy can respond to items in your In Box and Calendar and act on your behalf. A
proxy is another person who can be granted selective access to your In Box and Calendar
through the Access List you create.

1 Choose the Edit menu, then choose Preferences.

2 Click Environment in the icon list box.

3 Make sure the Environment pop-up menu shows Security Settings.

4 Click Access List, then double-click the users you want to select as your proxies.

The proxies are placed in the Access List box.

The Users list box lists all of
the users in the GroupWise
system.

Access List box

The check boxes let you
designate which options the
proxies have access to.

Access List dialog box

5 Select a proxy in the Access List box, then click the items you want the proxy to have
access to.

The table below explains the rights you can give to proxies.

Access Right Gives Proxy Rights to

Read Read the mail/phone, appointment, note, or task you receive.

Create Write and send mail/phone, appointments, notes, or tasks in
your name.

Read Private Items Read the items that you mark private.

Preferences Change any of the Preferences options in your mailbox and
edit your personal groups. The proxy can change your
GroupWise setup, add or remove proxies from your Access
List, and also use and change your Rules. Since the proxy
can also change your password, you would not normally grant
this right. See Rules in the reference manual.

Archive Place items in the Archive folder and retrieve them. If you
give a proxy archive rights, items archived by that proxy may
be stored on the proxy’s hard drive. See Proxies and Archive
in Tips and Hints below.

Notify Receive notification when you receive items.

Alarms Receive notification before the scheduled time of an
appointment.

6 Click OK.

When you want to remove a proxy from your Access List, select that proxy name in the
proxy list, then click Remove.
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Tips and Hints Proxies and Archive
When you give a proxy archive rights, you may need to specify the location of the Archive
folder. If the folder is located on the proxy’s hard drive, you will not have access to your
archived items unless the proxy publishes that folder. You may consider placing the folder
on a drive that both you and the proxy can have access to. See Archive and Environment
Preferences in the reference manual.
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About GroupWise Remote Disks
You can use the Client disks in the GroupWise 4.1 for Macintosh Client/Admin Pack to
install GroupWise Remote directly onto your stand-alone computer (such as a laptop). If
your system administrator copied the GroupWise installation program onto the network,
you can also install GroupWise Remote from the network to your computer.

The Remote Client disks are also available in the GroupWise Remote for Macintosh
Materials Pack, which includes a copy of this manual. To order the GroupWise Remote for
Macintosh Materials Pack or to receive the additional information, please call the
GroupWise Sales Center at (800) 861-2507.

If you are outside the United States, Puerto Rico, the U.S. Virgin Islands, or Canada,
please contact your local WordPerfect affiliate or authorized reseller.

Introduction
GroupWise Remote for Macintosh lets you perform many GroupWise functions while you
are away from your corporate office. These functions include sending and receiving mail,
scheduling meetings, writing notes, and assigning tasks.

Using GroupWise Remote is divided into two sections: Remote Basics and More About
Remote. Remote Basics is designed to help you install, set up, and begin using Remote.
More About Remote contains additional information that you might find helpful when using
Remote. For instructions on commonly-used GroupWise features, see Using GroupWise.
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Getting Started Checklist
This checklist summarizes the steps for getting started with GroupWise Remote for
Macintosh. The tasks are sequential.

Task

Verify that your computer meets the minimum hardware and
software requirements for running GroupWise Remote.

Read How GroupWise Remote Works. This section explains
the terminology and concepts you should understand before
setting up or using GroupWise Remote.

Fill out the worksheet (if your system administrator has not
done so already).

Start and set up GroupWise Remote.

Create a modem connection.

Create a network connection (if applicable).

Test your connections.

Retrieve information (items, Address Book, and so forth) from
your master mailbox.

Send items (messages, appointments, and so forth) to other
GroupWise users.

GroupWise Remote Requirements
Hardware and
Software
Requirements

You must run Remote on a computer that meets the minimum requirements listed below.

Hardware/Software Minimum
Requirements

Recommended Requirements

Processor Powerbook 140 Powerbook 180

System Version System 7 System 7 Pro or higher for drag
and drop and AOCE

Memory 2M available RAM 4M or more RAM

Hard Disk Space 14M available 20M or higher, depending on the
amount downloaded

System
Requirements

Remote requires you to have a mailbox (your master mailbox) on your master GroupWise
system. You must also have a password assigned to your master mailbox. Contact the
system administrator at your master site (the site of your master GroupWise system) if you
do not have a master mailbox and password.
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Terms You Should
Know

domain A collection of post offices; your post office belongs to a specific domain.

items Mail, appointments, tasks, notes, and phone messages.

master mailbox Your GroupWise mailbox in your master GroupWise system.

master site or master GroupWise system The GroupWise system where your master
mailbox is located.

master GroupWise system or master site The GroupWise system where your master
mailbox is located.

modem connection The modem link between your remote computer and your master
GroupWise system.

network connection The network link between your remote computer and your master
GroupWise system.

post office A collection of mailboxes; your master mailbox belongs to a specific post office.

Remote or GroupWise Remote The GroupWise program on your remote computer.

remote mailbox The mailbox that resides on your remote computer in GroupWise Remote.

requests When GroupWise Remote needs information from the master GroupWise
system, it builds a request. Requests are sent to the master GroupWise system which will
typically cause the master GroupWise system to produce a response to be retrieved later.

responses Packets of information containing your updated items, folders, rules, and groups
from the master GroupWise system. These responses update your remote mailbox so
that it reflects what is on the master GroupWise system.

retrieving Transferring information from your master mailbox to your remote mailbox.

sending Transferring information from your remote mailbox to your master mailbox.

GroupWise Remote or Remote The GroupWise program on your remote computer.

How GroupWise Remote Works
For GroupWise Remote to work, you must have a master mailbox on a networked
GroupWise system. GroupWise Remote exchanges items and information between your
master mailbox and the mailbox on your Remote computer.

For example, when you connect to the GroupWise system where your master mailbox is
located, GroupWise Remote copies any items your master mailbox received to the Remote
mailbox. Items you are sending from GroupWise Remote are copied to the Out Box in
your master mailbox.

Creating Requests
Whenever you perform an action that requires information to be sent from your remote
mailbox to your master mailbox, Remote creates a request. For example, requests are
created whenever you perform any of the following actions:

• Send, forward, delegate, or reply to an item
• Create a personal item, a folder, a group, or a rule
• Open, delete, retract, or undelete an item, or empty the Trash
• Ask to retrieve items, folders, or other information from your master mailbox
• Move items to a folder
• Delete a folder
• Delete a rule
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All requests are listed in the Pending Requests to Master Mailbox dialog box, shown
below.

Sending Requests
When you connect to your master GroupWise system, any requests that have a “Waiting
to be Sent” status in the Requests list are sent to your master mailbox. After a request is
sent to your master mailbox, the master GroupWise system processes it. For example, an
item you sent is added to your Out Box and distributed to its recipients, or a folder you
created is added to your master mailbox.

Retrieving Responses
Many of the requests that you send generate responses. Assume you have sent a request
to retrieve items from your master mailbox. After processing your request, your master
GroupWise system creates a response that contains the items you requested. Remote
can then retrieve and process the response.

Modem Connection Compared to Network Connection
To access your master mailbox to send or retrieve information, you must connect to your
master GroupWise system through a modem connection or a network connection.
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Modem Connection In most cases, you will probably use your modem to connect to your master GroupWise
system via a gateway, as shown below.

Post Office
with Your
Master
Mailbox

MASTER GROUPWISE SYSTEM

GroupWise
Gateway

Modem
Connection

Your Computer
with GroupWise

Remote

File
Server

Network
Connection

Remote can also use a network connection to connect to your master GroupWise system.
For example, if your computer has access to the post office containing your master
mailbox, Remote can use that network connection to send requests and retrieve
responses from your master mailbox.

Note: You can connect to any post office in your master GroupWise system to access your
master mailbox. You do not need to connect to the post office containing your master
mailbox.

Post Office
with Your
Master
Mailbox

MASTER GROUPWISE SYSTEM

Computer
with Your
Remote
mailbox

File
Server

File
Server

Post Office
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A network connection is very useful for retrieving your master mailbox and Address Book
to your remote computer before you leave your master site because it transfers
information faster than a modem connection. In particular, it can save long-distance
phone costs associated with retrieving your master mailbox or large user lists via a
modem.

Setup Worksheet
The following worksheet will help you gather the information necessary to set up
GroupWise Remote. It is divided into six sections that correspond to specific types of
information you need to know. The system administrator of your master GroupWise
system can assist you in filling out the worksheet.

User Information

Full Name

User ID

Master Mailbox Password

System Information

Domain

Post Office

Modem Information

Description (Name)

Port (if applicable)

Baud Rate (May depend on master
GroupWise system’s gateway modem. If
you are having difficulty synchronizing,
try using a lower baud rate.)

Time Zone Information

Remote User’s Time Zone

Time Zone observes Daylight Saving
Time?

Yes No
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Modem Connection Information

Connection Name

Gateway Phone Number

Gateway Login ID

Gateway Password

Modem Script (if required)

Disconnect Method* • When All Updates Are
Received

• Do Not Wait for Responses
• Manually

Redial Attempts* Default = 5

Redial Retry Interval* Default = 10 seconds

Network Connection Information

Connection Name

Path to Post Office

Disconnect Method* • When All Updates Are
Received

• Do Not Wait for Responses
• Manually

* Disconnect Method, Redial Attempts, and Redial Retry Interval have default settings.
Unless your system administrator supplies you with different values for these settings, use
the default settings for now. You will be given the opportunity to change them later.
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Starting GroupWise Remote
Logging in to
GroupWise Remote

To install GroupWise Remote to your remote computer, see Starting GroupWise under
Getting Started.

If you frequently download large amounts of information, you may want to increase the
preferred memory size for GroupWise. Before starting GroupWise, open your GroupWise
folder, click the GroupWise icon, then press c-I. Type 4096 in the Preferred size box, then
click the close box.

IMPORTANT: If you or your system administrator has not already filled out the worksheet,
do so now. See Worksheet.

Starting Remote To start GroupWise Remote,

1 Double-click the GroupWise icon.

2 Select Remote.

3 Click OK, then proceed to the next section, Setting Up GroupWise Remote.

If you want to enter a password for your remote mailbox, you can do so when GroupWise
Remote is activated. See Changing Your Remote Preferences under More About Remote.

Setting Up GroupWise Remote
The first time you start Remote, a list of information you need to enter appears. This is
where you’ll need the information from your worksheet.

Click to proceed.
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1 Type your full name and your GroupWise user ID as listed on your worksheet.

2 Click Password, type the master mailbox password listed on your worksheet, then
click OK.

3 Retype your password, then click OK.

4 Type the domain and post office names listed on your worksheet, then click OK.

5 Click Modem, select the modem listed on your worksheet, then click Select.

If your modem is not listed, try selecting a generic modem definition. If you need to create
a modem definition, see Creating or Editing a Modem Definition under More About
Remote.

6 Click Port, then select the modem or printer port.

If your PowerBook has an internal modem, select Internal Modem from the PowerBook
Control Panel.

7 Select the appropriate options from the pop-up menus, according to the information on
your worksheet, then click OK.

8 Click Set, select your time zone, then click OK.

If your area observes Daylight Saving Time, or the time offset is not one hour, you need to
edit the Daylight Saving Time. See Editing Daylight Saving Time in Setting or Changing
Your Time Zone under More About Remote.

HINT: Remember to set your remote computer’s clock to match the time zone you
selected. See Setting or Changing Your Time Zone under More About Remote.

9 When you’re done with the Daylight Saving Time settings, click OK.

10 Click Create, select Modem or Network, then proceed to Creating a Modem
Connection or Creating a Network Connection.

You can create both a modem connection and a network connection, then switch between
the connections depending on your current needs. For example, you can create a network
connection to use while at your office and a modem connection to use while away from
your office.
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IMPORTANT: We recommend that you do not switch between a modem connection and a
network connection or between gateways (for example, x.25, OS/2 Async, and DOS
Async) if there are pending requests on the connection you’re switching from.

Creating a Modem Connection
Creating a modem connection is similar to adding a phone number in a phone directory.
When you are away from your office, select a modem connection to send or retrieve
information from your master mailbox.

1 Click Create.

2 Select Modem, then click OK.

3 Type the connection name listed on your worksheet in the Connection Name box.

4 Type the gateway phone number listed on your worksheet in the Phone Number box.

IMPORTANT: You can use a comma (,) to signal a one-second pause in the dialing [such
as 9, (800) 555-1212]. The 9 accesses an outside line and the comma causes a one-
second pause to wait for the dial tone before dialing the number. Unrecognized symbols
such as dashes, spaces, and parentheses are ignored and can be included in the phone
number [such as (800) 555-1212.]

5 Type the gateway login ID listed on your worksheet.

Contact your system
administrator if a script is
required, and see Additional
Information at the end of this
section.

Your modem appears here.

6 Click Password, type the gateway password listed on your worksheet, then click OK.

7 Retype the password, then click OK.

8 Select the disconnect method you want.
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Disconnect Method Description
When All Updates Are Received Disconnects after requests are sent and all

responses to the requests are received (or
disconnects automatically when the time
allowed by the system administrator has
expired).

Do Not Wait for Responses [Fastest] Disconnects immediately after requests are
sent and waiting responses are received.
Waiting responses are responses that are
waiting for you at your master GroupWise
system.

Manually Lets you manually control when to
disconnect (or disconnects automatically
when the time allowed by the system
administrator has expired).

Your system administrator sets a time limit for Remote users to remain connected to the
master GroupWise system. If you select When All Updates Are Received or Manually as
your disconnect method, this time limit may cause you to be disconnected sooner than you
expected. If you are frequently disconnected in these modes, contact your system
administrator.

9 Type the number of times you want GroupWise Remote to automatically redial if the
line is busy in the Attempts box.

10 Choose the Retry Interval pop-up menu, then choose the interval between each
attempt.

11 Click OK.

If you want to create a network connection, proceed to the next section, Creating a
Network Connection.

If you want to begin using GroupWise Remote, proceed to Retrieving Information.

Additional
Information

Creating Additional Modem Connections
You can create more than one modem connection. For example, if your master
GroupWise system’s gateway has multiple phone numbers that you can use to call in, you
can create a modem connection for each phone number. Then, when connecting to your
master GroupWise system, you would choose the modem connection you want to use.

To create additional modem connections, repeat the steps you completed to create your
first modem connection, or copy and edit the first modem connection you created.

Editing a Modem Connection
From the Main Window,

1 Choose the Remote menu, then choose Send/Retrieve.

2 Click Connections.

3 Select the modem connection you want to edit, then click Edit.

4 Make your changes, then click OK.

5 Click OK.
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Scripting
Remote supports scripting. You can use a script file when Remote exchanges information
with your master site before it can connect to your master GroupWise system. For
example, you can use a script to provide information that lets Remote gain access through
your site’s security system or into a modem pool.

1 If you’re in the Modem Connection dialog box, go to step 5.

2 Start GroupWise, choose the Remote menu, then choose Send/Retrieve.

3 Click Connections.

4 Select the modem connection to add a script to, then click Edit.

5 If selecting an existing script, choose the Script pop-up menu, select the script, then
click OK.

If you are selecting an existing script, you are finished. If you are creating or editing a
script, continue with the remaining steps.

6 Click Edit.

7 Type the appropriate script commands, then click Save. See Script Language under
More About Remote for script commands and sample scripts.

8 Type the script name in the Save Script box, then click Save.

9 Click OK.

Creating a Network Connection
In addition to your modem connection, you can set up a network connection. For a
network connection, you must have network access to a post office directory on the
network.

1 Click Create.

2 Select Network, then click OK.

3 Type the connection name listed on your worksheet in the Connection Name box.
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4 Click Post Office, then use the directory dialog box to select your post office. (See
your worksheet.)

5 Select the disconnect method you want, then click OK.

Disconnects after requests are
sent and all responses to the
requests are received.

Lets you manually control
when to disconnect.

Disconnects immediately after
requests are sent and waiting
responses are received.

If you want to create a modem connection, see the previous section, Creating a Modem
Connection.

If you want to begin using GroupWise Remote, proceed to Retrieving Information.

Additional
Information

Editing a Network Connection
From the Main Window,

1 Choose the Remote menu, then choose Send/Retrieve.

2 Click Connections.

3 Select the network connection you want, then click Edit.

4 Make your changes, then click OK.

Testing Your Connections
Before trying to retrieve information from your master mailbox or send items to other
GroupWise users, you should verify that no problems exist with the connections you
created. Instructions for testing a modem connection and a network connection are
provided below.

Testing Your
Modem Connection

To verify that your modem connection works, you should connect to your master
GroupWise system.

From the Main Window,

1 Choose the Remote menu, then choose Send/Retrieve.

Connection pop-up menu

Testing Your Connections 75



2 Choose the Connection pop-up menu, then choose your modem connection.

Because you are simply testing the modem connection to see if it works, you should not
retrieve any information at this point. Retrieving information from your master GroupWise
system is discussed in the next section, Retrieving Information.

3 Deselect Items so that no information will be retrieved.

4 Click Connect to initiate the connection.

HINT: The modem on your remote computer will make a dialing sound which will change
to a screeching noise when it makes contact with your gateway’s modem. This procedure
could take several minutes depending on the number of times your modem dials before it
makes contact, and how many requests and responses your system has to transfer.

If the connection is working, the Connection Status dialog box displays a message stating
Status: Connected.

5 If your disconnect method is set to Manually, click Disconnect.

If the test was successful, skip to the next section, Retrieving Information.

If the test wasn’t successful, the GroupWise Error dialog box may appear.

6 Click OK in the GroupWise Error dialog box, then click Disconnect in the Connection
Status dialog box.

7 Choose Edit, then choose Preferences.

8 Click Remote, then click Modem.

9 Click Port, then check your worksheet to make sure that the settings are correct.

10 Close all dialog boxes, then repeat steps 1-5 above to retest the connection.

If the connection still does not work, contact your system administrator.

Testing Your
Network
Connection

To verify that your network connection works, you should connect to your master
GroupWise system.

From the Main Window,

1 Choose the Remote menu, then choose Send/Retrieve.

2 Choose the Connection pop-up menu, then choose your network connection.

Because you are simply testing the network connection to see if it works, you should not
retrieve any information at this point. Retrieving information from your master GroupWise
system is discussed in the next section, Retrieving Information.
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3 Deselect Items so that no information will be retrieved.

4 Click Connect to initiate the connection.

If the connection is working, the Connection Status dialog box displays a message stating
Status: Connected.

5 If your disconnect method is set to Manually, click Disconnect.

If the test was successful, skip to the next section, Retrieving Information.

If the test wasn’t successful, the GroupWise Error dialog box may appear.

6 Click OK in the GroupWise Error dialog box, then click Disconnect.

7 Choose the Remote menu, then choose Send/Retrieve.

8 Click Connections.

9 Select your network connection, then click Edit.

10 Check your worksheet to make sure the correct path appears in the Post Office box.

11 If the path is correct and your test is still unsuccessful, contact your system
administrator.

or

Type or select the correct path as listed on your worksheet, then click OK.

12 Click OK, then re-test the connection.

Retrieving Information (Downloading)
Once you have successfully tested your connection, you can retrieve information from your
master mailbox to your remote mailbox.

Retrieving Items From the Main Window,

1 Choose the Remote menu, then choose Send/Retrieve.

Items check box Items button
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2 Make sure the Items check box is selected, then click Items.

Specify the items you want to
update.

Deselect a check box if you don’t
want to update it.

3 Specify your Item Size Limits and Time Period settings, explained below.

Option Description
Get Subject Line Only If you generally retrieve a large number of items,

this option can help save time and reduce phone
costs by retrieving only the subject line of each
item. See Retrieving Selected Items in
Additional Information at the end of this section.

Get Contents Regardless of Size Retrieves all items and attachments in your
master mailbox.

Get Contents If Smaller Than Retrieves all items that meet the size limits you
specify. See Retrieving Selected Items in
Additional Information at the end of this section.

From...to... Lets you specify a number of days prior to and
after today’s date to retrieve only the items that
fall between a range.

4 Click OK, then continue with Retrieving Your Address Book.

Retrieving Your
Address Book

Your Address Book can be very helpful when you are unsure about user IDs, resource
names, or public group names, or when you need to address an item to several users. If
you want to use the Address Book in Remote, you need to retrieve it from your master
GroupWise system. If you do not want to retrieve your Address Book, skip to Connecting
to Your Master GroupWise System below.

HINT: Since this process can take quite some time, we recommend retrieving your
Address Book through a network connection while at your master site.

1 Make sure the Send/Retrieve dialog box is open.

2 Click the Address Book check box, then click the Address Book button.

3 Select the option you want and, if necessary, type the domain and post office names in
the appropriate boxes.
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4 Click OK, then continue with Connecting to Your Master GroupWise System below.

HINT: You can also retrieve folders, rules, public group members, and personal groups.
For information about each of these options, choose the n menu, choose GroupWise
Help, then choose the topic you want to learn about.

Connecting to Your
Master GroupWise
System

Connecting to your master GroupWise system sends the number of items displayed in the
Send/Retrieve dialog box to your master GroupWise system. It also retrieves items from
your master mailbox to your remote mailbox, restricting them according to the limits you
set on your retrieve selections.

Initiating the Connection

1 Make sure the Send/Retrieve dialog box is open and that you have selected all the
information you want to retrieve.

2 Choose the Connection pop-up menu, choose the connection you want, then click
Connect.

HINT: If you’re using a modem connection, the modem on your remote computer will make
a dialing sound which will change to a screeching noise when it makes contact with your
gateway’s modem. This procedure could take several minutes depending on the number
of times your modem dials before it makes contact, and how many requests and
responses your system has to transfer.

This will read “Connected”
when you have made a
successful connection.

Displays maximum connection
information

You can disconnect from your master GroupWise system anytime by clicking Disconnect
in the Connection Status dialog box.

Logging Your Connection Information
Remote logs information to the Connection Log dialog box and to a logfile (Connection
Log) on your hard drive. Choosing Show Log displays maximum connection information.
This includes modem initialization commands, connection time, error messages, and so
forth. Show Log is useful if you need to troubleshoot a connection problem.

Additional
Information

Retrieving Selected Items
After you have retrieved items from your master mailbox, you can release size limits you
may have set on those items. Assume you chose Get Subject Line Only in Item Size
Limits, and, after reading the subject lines of your items, you want to read the contents as
well. Retrieve Selected Items lets you reconnect with your master mailbox and retrieve the
contents of the items you selected.

From the Main Window,

1 Double-click In Box, Out Box, or My Calendar, depending on where the item is that
you want to retrieve.

2 Select the items you want to retrieve.

3 Choose the Remote menu, then choose Retrieve Selected Items.

4 Click Connect.
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Remote connects with your master GroupWise system using the same connection as your
most recent connection. You can change the connection, if you want.

5 If your Disconnect Method is set to Manually, click Disconnect after all items have
been retrieved to your remote mailbox.

Sending Items (Uploading)
Now that you have retrieved your items and Address Book, you are ready to send items to
other users. The following steps explain how to send a mail message. The procedure is
similar for sending appointments, tasks, notes, and phone messages.

From the Main Window,

1 Double-click Send Mail to open the mail view.

2 Click Address.

3 Drag user IDs to the Send To, Carbon Copy, and Blind Copy boxes.

4 Click OK.

5 Type a description of the message in the Subject box.

6 Type the message in the Message box.

7 If you want to change the send options for the mail message, choose the Edit menu,
then choose Options. Set the options you want, then click OK.

8 Click Send.

The mail message is placed in the Requests list. As soon as you connect to your master
GroupWise system, it will be sent.

Connecting to Your
Master GroupWise
System

1 Choose the Remote menu, then choose Send/Retrieve.

2 Choose the Connection pop-up menu, choose the connection you want, then click
Connect.
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HINT: If you’re using a modem connection, the modem on your remote computer will make
a dialing sound which will change to a screeching noise when it makes contact with your
gateway’s modem. This procedure could take several minutes depending on the number
of times your modem dials before it makes contact, and how many requests and
responses your system has to transfer.

This will read “Connected”
when you have made a
successful connection. Displays maximum connection

information

You can disconnect from your master GroupWise system anytime by clicking Cancel.

Addressing
This section explains how to address an item to a user who is not on your post office. See
Sending Mail under Using GroupWise Basics for information on how to address an item by
choosing user IDs from the Address Book or by typing the user IDs in the address boxes.

GroupWise allows for multiple post offices and domains. Normally, your system
administrator will include each connected domain so all users are listed in the Address
Book. However, the system administrator can exclude users from the Address Book who
don’t want to be listed. You can still send items to those users if you type the full address.

Absolute
Addressing Absolute addressing is like addressing a letter (for example, Lia Elstead, 121 Liberty

Street, Kanoa, Utah, 88434). Each GroupWise user and resource has an absolute
address consisting of the user’s or resource’s domain, post office, and ID. If you don’t
know the absolute address of a user, contact your system administrator. To use the
absolute address, you must type it in the address box using the syntax shown below.

domain.po.userID

When typing addresses for multiple users in different post offices, separate the addresses
with commas, as shown below.

domain.po1.userID, domain.po2.userID

If multiple users are on the same post office, you can place all the users in that post office
in parentheses and separate them with commas.

domain.po(user1ID, user2ID, user3ID)

Explicit Addressing Explicit addressing is used when you need to address an item through a gateway or
through one or more domains to reach the recipient’s domain. An explicit address
describes the pathway from your domain to the recipient’s domain in the same way you
would give someone directions to a hotel (for example, go to the park, turn right and go to
the cathedral, turn left and go three blocks, turn left and you will see the hotel).
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Explicit addressing includes each gateway, domain, and post office the item passes
through before it reaches its destination. A path from one domain to another is designated
by a colon. A path from a domain to a post office, and a post office to a user, is
designated by a period, as illustrated below.

domain:domain:domain.po.userID

You can also reverse the order of the address and separate the domains, post office, and
user ID with the @ symbol.

userID@po@domain@domain

If you do not know the explicit address for a user, contact your system administrator.

If you need to address an item through a gateway (such as a gateway for sending a fax),
you will need to use explicit addressing. The syntax for addressing an item through a
gateway depends on the gateway you are using. Contact your system administrator for
the syntax you need to use for the gateway you are using.

Internet
Addressing

You can address an item to an Internet user through a GroupWise gateway, such as the
Simple Mail Transfer Protocol (SMTP) gateway.

The GroupWise SMTP Gateway provides the following flexible addressing options:

• gateway:“user@host”
• foreign domain:user@host
• post office@host
• The GroupWise Address Book (see Address Book in the reference manual)

Contact your system administrator to find out which addressing methods are available for
your GroupWise system, and the gateway or foreign domain names you need to use. For
more information on available gateways, please call the GroupWise Sales Center (800-
861-2507).

Creating an
Address Alias

If you find that you are often typing the same address to send items, you can simplify
sending items by creating an alias for the address. An alias is a personal group you create
to simplify the name of a user whose address is across one or more gateways or domains,
or in a different post office.

For example, instead of typing the address, telephone number, and options each time you
send an item to a fax gateway, you can create a personal group for each number you fax
to. When you want to address to the fax gateway and send to that number, you type the
name of the personal group that contains the fax gateway information.

1 Choose the Tools menu, then choose Address Book.

2 Click External Address, type the address(es), then click To, CC, or BC.

3 Click Save Group, type a name for the group, then click OK.

4 Click OK when you are done.
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Changing Your Remote Preferences
You can change any of the user and system information, default settings, and connection
definitions that you set in Remote Preferences.

IMPORTANT: Changing the user ID, domain, or post office will cause you to lose all
information in your remote mailbox.

From the Main Window,

1 Choose the Edit menu, then choose Preferences.

2 Scroll down the Category list box, then click Remote.

3 Select your options, make your changes, then click OK.

If you changed the user ID, domain, or post office, a prompt box appears telling you which
information you changed and warning you that all information in your remote mailbox will
be lost. Click Yes to continue or click No, then Cancel if you do not want to save the
changes.

Creating or Editing a Modem Definition
When you create or edit a modem definition, you describe the details of your remote
computer’s modem so Remote knows the proper specifications to use to connect to your
master GroupWise system.

Refer to your modem manual as you create or edit your modem definition.

Specifying Modem
Settings

From the Main Window,

1 Choose the Edit menu, then choose Preferences.
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2 Scroll down the Category list box, then click Remote.

3 Click Modem to open the Modem Configuration dialog box.

4 Click Modem to open the Modems dialog box.

5 Click Create, then type the modem name in the Description box.

or

Select the modem you want to modify, then click Edit.

6 Type the applicable information from the table below in the Commands group box.

Text Box Definition

Initialization The commands used by Remote to initialize the
modem. The Initialization box can contain a
maximum of 255 characters. If you need multiple
lines in the command string, use the single prime
( ) to embed control characters such as a hard
return. See Modem Initialization Commands in
Additional Information at the end of this section for
details.

Hang Up The commands needed for the modem to hang up
and reset itself.

Dialing The commands to dial the modem. Include any
commands for tone or pulse dialing, dial pauses,
and so forth.

Suffix This field is usually not required. It is used only for
special cases such as cellular phones.

Answer This option does not apply. Remote cannot answer
incoming calls.

No Answer The command to disable answering of calls.
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If your modem provides error correction, you need to choose the error correction type and
define the correction string. If not, skip to step 10 below.

7 Choose the Type pop-up menu, then choose the protocol type you want.

Five common error correction
protocols are listed, as well as
an Other option for the
protocol of your choice.

8 Type the error correction commands in the String box. Contact your system
administrator for the appropriate commands.

9 Click Auto Baud Detect if you defined your computer’s modem and your gateway’s
modem at different baud rates.

Auto Baud Detect will synchronize the modems at the slower of the two rates to allow the
modems to communicate with each other.

10 Type a number between 0 and 10 in the Pacing box.

The character pacing is the time interval between each character GroupWise sends to the
modem when the modem is in command mode. The number you enter represents 1/10 of
a second. For example, typing 10 will cause a one-second pause between characters.
Type 0 if your modem does not require a pause between each character.

11 Type the escape character that instructs the modem to switch from terminal mode to
command mode in the Escape Character box.

12 If you are using a wireless modem, click Delayed Time Out to extend the time out
value for GroupWise.

13 Choose the Baud Rate pop-up menu, then select the maximum baud rate that the
modem can use to receive information from Remote.

14 Click OK to save the definition.

15 Make sure the modem you created is selected, then click Select.

The modem name appears in the Modem field.

Specifying Port
Settings

The Port Settings dialog box displays the serial port and baud rate for the modem you just
specified. If either of these are incorrect, you need to edit the port settings.
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1 Choose Port in the Modem Configuration dialog box.

2 Click the modem icon to specify settings locally.

or

Click the printer port icon to go to a modem pool on the network.

or

If your PowerBook has an internal modem, select Internal Modem from the
PowerBook Control Panel. This overrides the Port Settings preferences.

3 Choose the appropriate value in the corresponding pop-up menu for each setting. The
settings are described below.

Setting Definition
Baud Rate The baud rate the modem should use when sending and receiving

information from the gateway.

Parity Parity Bit is None. This probably will not need to change. Contact
your system administrator.

Data Bits Character Length is 8. This probably will not need to change.
Contact your system administrator.

Stop Bits Stop Bits is 1. This probably will not need to change. Contact your
system administrator.

Flow Control Flow Control is CTS/DTR. This probably will not need to change.
Contact your system administrator.

Dial Type If only pulse dialing is available in your calling area, choose Pulse.

4 Click OK.

5 Return to the Main Window and test your connection to verify that it works. See
Testing Your Connections under Remote Basics.

Additional
Information

Modem Initialization Commands
The commands used by Remote to initialize the modem include the following:

• Enable verbal result codes
• Turn command echo off
• Track data carrier
• Return CONNECT messages
• Drop carrier and reset modem when DTR drops
• Link DTE speed to appropriate speed indicated by DCE CONNECT message. See

table below.

CONNECT Message DTE Speed

CONNECT 300
CONNECT 1200 1200
CONNECT 2400 2400
CONNECT 4800 4800
CONNECT 7200 9600
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CONNECT Message DTE Speed
CONNECT 9600 9600
CONNECT 12000 19200
CONNECT 14400 19200
CONNECT 19200 19200
CONNECT FAST 19200

Script Language
Scripts contain 8 pairs of When given and Respond with fields. When given fields can
be a maximum of 17 bytes (characters). Respond with fields can be a maximum of 49
bytes. If a Respond with string exceeds the 49-byte limit, you can leave the next When
given field empty and continue in the next Respond with field.

Script Commands All of the commands described below can be in uppercase or lowercase.

Command Description

^character Outputs the specified control character. Common control
characters are ^m (carriage return), ^j (line feed), ^i (tab), and ^[
(escape).

 Waits 0.5 seconds.

@A[#]"text" Asks for the question in the quotes, prompt for a response, and
then send the response to the modem. The number (0 or 1) in
the square brackets is optional. 0 echoes the response while 1
specifies no echo.

@B[#] Sends a break signal # milliseconds long. For example, 1000
causes a 1-second break.

@D[#] Controls screen display for modem output. Display off is 0,
display on is 1.

@O[#] Controls modem and screen display for script output. Modem
display only is 1, screen display only is 2, and both is 3.

@P"br,pb,db,sb" Modifies port parameters. The first parameter is baud rate (valid
numbers), then parity bit (N, E, O), then data bits (7, 8), and then
stop bits (1, 2). Any field can be omitted and commas
concatenated (for example, @P"2400,n,,1"). If a field is omitted,
the current setting is used.

@T Uses Dumb Terminal mode. Dumb Terminal mode echoes
everything, regardless of the @D or @O settings. F7 exits you
from the mode.

@W[#] Waits for # milliseconds before continuing with next command.
0 instructs Remote to wait until the output buffer is empty. A
number instructs Remote to wait the specified time. For
example, 1000 instructs Remote to wait 1 second.

Sample Scripts The following is a sample script for exchanging information with a Blackbox security
system that is set up for callback. Notice that the first When given field is left empty. This
will usually be the case because you are initiating the conversation.

When given Respond with

^MATDT888^M
PRIMARY  wendy^M
ACCEPT @D[1]
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When given Respond with
NO CARRIER  ATSO=2^M
SECOND  peters^M
ACCEPT ^M

The following script is similar to the above script, except the Blackbox security system is
set up for passthrough.

When given Respond with
^MATDT888^M

PRIMARY  ed^M
SECOND  jones^M
ACCEPT  ^M

Setting or Changing Your Time Zone
All items in your Calendar are scheduled according to the time zone you chose when you
initially set your Remote Preferences. As you cross time zones with GroupWise Remote,
you can change to the new time zone. If you do, all scheduled items will change to reflect
the difference between the time zones.

For example, assume you chose Eastern in your initial Remote Preferences, and you are
currently working in the Pacific time zone. If you change your time zone in Remote to
Pacific, a 3 p.m. appointment will display as a 12 noon appointment in Remote.

IMPORTANT: If you change Remote’s time zone, be sure to change your remote
computer’s clock to match the new time zone. See Changing Your Computer’s Clock later
in this section.

From the Main Window,

1 Choose the Edit menu, then choose Preferences.

2 Scroll down the Category list box, click Remote, then click Time Zone.

3 Click Set.

4 Select the new time zone, then click OK.

5 Click OK, then return to the Main Window.

Editing Daylight
Saving Time

Use Edit Daylight Saving Time to specify when daylight time and standard time begin.

1 Choose the Edit menu, then choose Preferences.

2 Scroll down the Category list box, click Remote, then click Time Zone.

3 Click Use Daylight Saving Time, then click Edit.

4 Select Define by Day or Define by Date.

5 Specify when daylight saving time begins and when standard time begins using the
pop-up menus.

6 Specify the number of hours and minutes your clock should change, then click OK.

7 Click OK, then return to the Main Window.
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Changing Your
Computer’s Clock

Always change the clock in your remote computer when you change Remote’s time zone.
This will ensure synchronization of all scheduled items between your new time zone and
your computer’s clock.

1 Choose the n menu, then choose Control Panels.

2 Double-click Date & Time, make your changes, then click the close box.

HINT: You may prefer not to change time zones when you travel. If you are in New York
and schedule an appointment in Los Angeles for 3 p.m., then fly to California and choose
not to change time zones in Remote, the appointment will still display at 3 p.m. and your
schedule will not be altered.

Generally, if you’re planning to work in another time zone at length, you may find it
preferable to change your time zone in Remote.

Rebuilding Your GroupWise Remote Database
If you have problems using GroupWise Remote (for example, your items don’t open), you
may need to rebuild the GroupWise Remote database.

1 Double-click the GroupWise icon to start GroupWise.

2 When you are ready to log in to GroupWise Remote, hold down the Control, Option,
and c keys, and click OK.

3 Click Yes.

4 Use the directory dialog box to indicate where you want to save the log file, type the
filename, then click Save.

You can open the log file to see if there is any record of problems. The log file is in
TeachText format. Just double-click the file to open it.
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